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insecure functioning could result in damage to persons or property, denial of service, or loss of privacy.

All intellectual property is protected by copyright. All trademarks and product names used or referred to are the
copyright of their respective owners. No part of this document may be reproduced, stored in a retrieval system or
transmitted in any form or by any means, electronic, mechanical, chemical, photocopy, recording or otherwise without
the prior written permission of Gemalto.
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PREFACE

About the SafeNet ProtectToolkit-M User
Guide

This document provides instructions on installation, configuration, administration, and troubleshooting for the SafeNet
ProtectToolkit-M suite of applications. It contains the following chapters:

e "Overview" on page 11

* "Installation" on page 14

e "Setup and Configuration" on page 16

¢ "Administrative Tasks" on page 32

e "UserTasks" on page 42

e "Administration and User Utilities" on page 46
¢ "Integration with Microsoft CA" on page 65

¢ "Known Issues" on page 77

* "PKCS #11 Attributes" on page 86

e "Integration With [I1S" on page 80

e "Work Load Distribution" on page 88

* "Registry Configuration" on page 101

e "Event Log Error Types" on page 105

e "Glossary of terms" on page 108

This preface also includes the following information about this document:
e "Customer Release Notes" below

¢ "Gemalto Rebranding" on the next page

¢ "Audience" on the next page

¢ "Document Conventions" on the next page

e "Support Contacts" on page 10

For information regarding the document status and revision history, see "Document Information” on page 2

Customer Release Notes

The customer release notes (CRN) provide important information about this release that is not included in the customer
documentation. It is strongly recommended that you read the CRN to fully understand the capabilities, limitations, and
known issues for this release. You can view or download the latest version of the CRN for this release at the following
location:
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PREFACE About the SafeNet ProtectToolkit-M User Guide

http://www.securedbysafenet.com/releasenotes/ptk/crn_ptk_5-3.pdf

Gemalto Rebranding

In early 2015, Gemalto completed its acquisition of SafeNet, Inc. As part of the process of rationalizing the product
portfolios between the two organizations, the Luna name has been removed from the SafeNet HSM product line, with
the SafeNet name being retained. As a result, the product names for SafeNet HSMs have changed as follows:

Old product name New product name

ProtectServer External 2 (PSE2) SafeNet ProtectServer Network HSM
ProtectServer Internal Express 2 (PSI-E2) SafeNet ProtectServer PCle HSM
ProtectServer HSM Access Provider SafeNet ProtectServer HSM Access Provider
ProtectToolkit C (PTK-C) SafeNet ProtectToolkit-C

ProtectToolkit J (PTK-J) SafeNet ProtectToolkit-J

ProtectToolkit M (PTK-M) SafeNet ProtectToolkit-M

ProtectToolkit FM SDK SafeNet ProtectToolkit FM SDK

@ Note: These branding changes apply to the documentation only. The SafeNet HSM software
and utilities continue to use the old names.

Audience

This document is intended for personnel responsible for maintaining your organization's security infrastructure. This
includes SafeNet ProtectToolkit users and security officers, key manager administrators, and network administrators.

All products manufactured and distributed by Gemalto are designed to be installed, operated, and maintained by
personnel who have the knowledge, training, and qualifications required to safely perform the tasks assigned to them.
The information, processes, and procedures contained in this document are intended for use by trained and qualified
personnel only.

It is assumed that the users of this document are proficient with security concepts.

Document Conventions

This document uses standard conventions for describing the user interface and for alerting you to important information.

Notes

Notes are used to alert you to important or helpful information. They use the following format:

@ Note: Take note. Contains important or helpful information.
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Cautions

Cautions are used to alert you to important information that may help prevent unexpected results or data loss. They use
the following format:

i CAUTION: Exercise caution. Contains important information that may help prevent
unexpected results or data loss.

Warnings

Warnings are used to alert you to the potential for catastrophic data loss or personal injury. They use the following
format:

WARNING! Be extremely careful and obey all safety and security measures. In this
situation you might do something that could result in catastrophic data loss or
personal injury.

Command Syntax and Typeface Conventions

Format Convention

bold The bold attribute is used to indicate the following:

*  Command-line commands and options (Type dir /p.)

e Button names (Click Save As.)

*  Check box and radio button names (Select the Print Duplex check box.)

* Dialog box titles (On the Protect Document dialog box, click Yes.)

* Field names (User Name: Enter the name of the user.)

¢ Menu names (On the File menu, click Save.) (Click Menu > Go To > Folders.)
* Userinput (In the Date box, type April 1.)

italics In type, the italic attribute is used for emphasis or to indicate a related document. (See the
Installation Guide for more information.)

<variable> In command descriptions, angle brackets represent variables. You must substitute a value for
command line arguments that are enclosed in angle brackets.

[optional] Represent optional keywords or <variables> in a command line description. Optionally enter the

[<optional>] keyword or <variable> that is enclosed in square brackets, if it is necessary or desirable to
complete the task.

{alblc} Represent required alternate keywords or <variables> in a command line description. You must

{<a>|<b>|<c>} | choose one command line argument enclosed within the braces. Choices are separated by vertical
(OR) bars.

[a|b|c] Represent optional alternate keywords or variables in a command line description. Choose one

[<a>|<b>|<c>] | command line argument enclosed within the braces, if desired. Choices are separated by vertical
(OR) bars.
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Support Contacts

If you encounter a problem while installing, registering or operating this product, please make sure that you have read
the documentation. If you cannot resolve the issue, please contact your supplier or Gemalto support. Gemalto support
operates 24 hours a day, 7 days a week. Your level of access to this service is governed by the support plan
arrangements made between Gemalto and your organization. Please consult this support plan for further information
about your entitlements, including the hours when telephone support is available to you.

Contact method Contact
Address Gemalto
4690 Millennium Drive
Belcamp, Maryland 21017
USA
Phone Global +1410-931-7520
Australia 1800.020.183
China (86) 10 8851 9191
France 0825 341000
Germany 01803 7246269
India 000.800.100.4290
Netherlands 0800.022.2996
New Zealand 0800.440.359
Portugal 800.1302.029
Singapore 800.863.499
Spain 900.938.717
Sweden 020.791.028
Switzerland 0800.564.849
United Kingdom 0800.056.3158
United States (800) 545-6608
Web https://safenet.gemalto.com
Support and Downloads https://safenet.gemalto.com/technical-support
Provides access to the Gemalto Knowledge Base and quick downloads for
various products.
Technical Support Customer | https://serviceportal.safenet-inc.com
Portal Existing customers with a Technical Support Customer Portal account can log in
to manage incidents, get the latest software upgrades, and access the Gemalto
Knowledge Base.
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Overview

This section introduces SafeNet ProtectToolkit-M and shows how SafeNet components and terminology apply in the
Microsoft Cryptographic API environment.

SafeNet ProtectToolkit-M Applications

With SafeNet ProtectToolkit-M installed, applications that call the Microsoft Cryptographic APl (MSCAPI) can make
use of the secure key storage and high-speed cryptographic processing offered by SafeNet hardware security modules
(HSMs).

The Microsoft Cryptographic APl (MSCAPI) provides security services for a range of applications, such as web-based
SSL processes.

Microsoft Certification Authority (MSCA) and Internet Information Services (IIS) (a Microsoft web server) use the
MSCAPI and therefore may be integrated with SafeNet ProtectToolkit-M. An MSCA may store CA keys on an HSM,
while IS may use HSM key storage when establishing secure socket layer (SSL) communication.

The MSCAPI Model and SafeNet ProtectToolkit-M

Cryptographic Service Providers
SafeNet ProtectToolkit-M is implemented as a Microsoft Cryptographic Service Provider (CSP).

A CSP is a plug-in cryptographic module that integrates with Microsoft Windows and provides the underlying key
storage and security operations for the Microsoft Cryptographic APl (MSCAPI). The architecture of the MSCAPI
supports the development of non-Microsoft CSPs such as SafeNet ProtectToolkit-M.

SafeNet ProtectToolkit-M includes both “RSA Full” and “RSA SChannel” cryptographic service providers. These can be
used instead of the corresponding Microsoft CSPs to provide hardware-based key storage and RSA encryption.

MSCAPI Implementation Using SafeNet ProtectToolkit-M

"SafeNet ProtectToolkit-M model" on the next page shows how SafeNet HSMs can be utilized as part of a MSCAPI
system, using SafeNet ProtectToolkit-M as a CSP.

SafeNet ProtectToolkit User Guide
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Overview

Figure 1: SafeNet ProtectToolkit-M model
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Within MSCAPI (and hence SafeNet ProtectToolkit-M), key pairs are held within a key container, which is stored within

a keyset.
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Each user requiring processing support from the SafeNet ProtectToolkit-M system will need a user keyset containing a
key container. Key containers may contain up to 2 key pairs: a signature key pair and an exchange key pair.

Apart from this, there are two keysets required by the SafeNet ProtectToolkit-M system for its internal processes.
These are the SYSTEM keyset and the MACHINE keyset, which are visible to all system users. SafeNet
ProtectToolkit-M cannot operate without either of these and will automatically create either set if they are not present or
deleted. Shared keys (accessible by more than one user), such as those generated automatically when Microsoft CA is
installed, will also be stored in one of these keysets when using a SafeNet ProtectToolkit-M CSP. Generally these
shared keys are stored in the MACHINE keyset.

The physical storage location for each keyset is CSP-dependent. By default, Microsoft CSPs store keys to disk, in
user profiles. When using the “Safenet RSA Full” or “Safenet RSA SChannel” CSPs, all keys are secured by SafeNet
ProtectToolkit-M within SafeNet hardware security modules (HSMs).

Further Documentation

The following reference material should be considered in addition to this user manual:
» SafeNet ProtectServer PCle HSM Installation Guide

e SafeNet ProtectServer Network HSM Installation/Configuration Guide

» SafeNet HSM Access Provider Installation Guide

¢ Microsoft documentation on cryptographic service providers. See their web site.
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Installation

This section details installation and uninstallation components and instructions on the following:
* SafeNet ProtectToolkit-M Runtime
o SafeNet KSP (for CNG)

Requirements

Before beginning with the SafeNet ProtectToolkit-M installation, please confirm that your system meets the following
minimum requirements:

e Microsoft IS (Internet Information Services) should be installed, configured and working if integration with IS is
desired.

e A SafeNet ProtectServer hardware security module (HSM) must be available. An adapter can be installed in the
local machine or a device may be made available via a network connection.

Installing the SafeNet ProtectToolkit-M software

If a previous version of SafeNet ProtectToolkit-M is installed, uninstall it prior to installing the newer software. The
latest versions of the client software and HSM firmware can be found on the Gemalto eService Support Portal at
https://serviceportal.safenet-inc.com.

To install the SafeNet ProtectToolkit-M software:

@ Note: Full support for SafeNet ProtectToolkit-M is provided on 64-bit versions of Windows
only. 32-bit versions support KSP only.

1. Open Windows Explorer and execute the file PTKmprt32.msi or PTKmprt64.msi found in <path to installer
directory>\Win64\Ptk-M.

2. Follow the on-screen instructions to complete the installation. During installation you will be required to:
a. choose the directory where the software will be installed, and
b. nominate either alocally connected or network connected HSM as the cryptographic service provider.

Following the installation, continue to "Setup and Configuration" on page 16 for details on how to configure and setup
the SafeNet ProtectToolkit-M product.

KSP (for CNG)

To install the SafeNet KSP for CNG, run the relevant Win32\SafenetK SP32.msi or Win64\SafenetK SP64.msi
installer.
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2 Installation

See special KSP configuration instructions in "KSP (for CNG) Configuration” on page 23.

Uninstalling the SafeNet ProtectToolkit-M software

To uninstall the SafeNet ProtectToolkit-M software:

1. If the key information stored on the HSM is no longer required, tamper the HSM in order to destroy it. See the
Tampering the Adapter section for further instructions if needed.

2. Ifthe PCle HSM access provider is installed, you must uninstall it before uninstalling the SafeNet ProtectToolkit-M
software. Failure to do so may prevent the SafeNet ProtectToolkit-M software from uninstalling correctly.

3. Usethe Programs and Features control panel to uninstall the SafeNet ProtectToolkit-M software.

SafeNet ProtectToolkit User Guide
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Setup and Configuration

After installing SafeNet ProtectToolkit-M it is necessary for the device administrator to:
e initialize the HSM

* set the security mode

* allocate keyset space

* create userkeysets (This is optional as users may also create their own keysets)

* setup work load distribution (WLD) if required

After the device administrator has performed the above steps then users will typically need to undertake the following
tasks:

* create keysets

* add containers to keysets

e generate key pairs in containers

To perform these tasks follow the procedures described in this section:
e "UserRoles" below

* "Initial Configuration: Mandatory Steps" on the next page

* "Allocating Keyset Space" on page 21

* "Configuration Options" on page 22

e "KSP (for CNG) Configuration" on page 23

e "Configuring I1S7 (Win2008) with CNG" on page 25

User Roles

Prior to performing any configuration, it is important to understand the different SafeNet ProtectToolkit-M roles available
and to determine which type of role an individual will assume.

There are two defined roles available. These are:
* A SafeNet ProtectToolkit-M device administrator; and
¢ A SafeNet ProtectToolkit-M user

These roles are described below.

Device Administrator

The device administrator is responsible for tasks that involve management of the associated HSM and those applicable
to SafeNet ProtectToolkit-M administration. Those assigned to this role are also responsible for performing backup and
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3 Setup and Configuration

restore operations for MACHINE and SYSTEM keysets and allocation of space for user keysets.

User

A SafeNet ProtectToolkit-M user is responsible for the creation and management of their own keyset stored within a
HSM. This includes responsibility for backup and restore of their own keyset, the key container and associated key
pairs.

Initial Configuration: Mandatory Steps

Initializing the HSM

SafeNet ProtectToolkit-M uses a hardware encryption HSM to store sensitive key information. The HSM needs to be
initialized prior to use, or following a tamper event. A tamper event occurs, for example, if the HSM detects that
someone is trying to get inside the cover. It will then automatically erase its secure memory.

HSM management tasks can only be performed by a device administrator. During HSM initialization, the device
administrator password is set, and the HSM clock is synchronized with the host.

To initialize the HSM:

1.  Open the Administration Utility by selecting Start > Programs > SafeNet > ProtectToolkit M > gmadmin. A
prompt displays to set the new device administrator password.

2. Enterthe password in both the Admin Password and Confirmation fields and, if required, check “Keep Password
For Session”. For added security, leave the “Keep Password For Session” box unchecked. Password entry will
then be required to complete every task. For convenience, check this box so that password entry will not be
required again until after the utility is closed and reopened.

3. Click OK. The MACHINE and SYSTEM keysets are now created. The Administration Utility dialog box displays
showing MACHINE and SYSTEM keyset icons under Active Adapters as shown below.

Active Adapters
S ] device:0

M MACHINE_Keyset
-4} SYSTEM_Keyset

Setting Security Modes and Security Flags

The security mode for the HSM is chosen by specifying the value of a number of security flags. These flags affect both
the services available to the various users of the system as well as specific security features of the HSM. These flags
may be specified individually to set a custom security mode, however it is recommended that a standard security mode
be used. When a standard security mode is selected the flags are assigned values automatically to meet the
requirements for that mode.

Note: The security mode should be set prior to commencing normal operation. It is
recommended that the impact of any proposed security mode change be carefully assessed to
be applicable prior to implementation.

SafeNet ProtectToolkit User Guide
Release 5.3 007-013682-001 Rev. A December 2016 Copyright 2009-2016 Gemalto Al rights reserved.



3 Setup and Configuration

To set a security mode:

1. Ifitis not already open, launch the Administration Utility from the Start menu by selecting Start > Programs >
Safenet > ProtectToolkit M > gmadmin.

2. Fromthe All Adapters menu, select Set Security Flags. The Set Security Flags — All Devices dialog box
displays.

Set Security Flags - Device 0 |

— Security Mode Flags

[~ Tamper Before Upgrade [ Lock Security Mode

[~ Mo Public Cryptography [ Increased Security Mode

[~ Entmust Compliant [~ Only &llow FIPS Approved Algarithms
[~ MoClear FIMz [~ Full Secure Meszaging Enciyption
[~ Authentication Protection [~ Full Secure Meszaging Signing

— Security Modes

FIPS 140 Resticted | Set Al Clearl |

Cancel |

3. Either:

a. change flag values to those required (see "Security Mode Flag Descriptions" on the next page) in the Security
Mode Flags group box

b. click a security mode button in the Security Modes group box to set a standard security mode. See "Security
Mode Descriptions" below.

Click OK and enter the administration password if prompted. A confirmation message is displayed.
Click OK to return to the Administration Utility dialog box.

Security Mode Descriptions

This section describes the security modes that can be selected from the Security Modes group box in the Set Security
Flags — All Devices dialog box.

Set All and Clear All Modes
* Click Set All to set all available security flags.

¢ Click Clear All to remove all security flags.

FIPS 140 Mode

FIPS 140 Mode refers to the security flag settings required to comply with the Federal Information Processing
Standards (FIPS) 140 standard.

It is important to note that the product can function outside the scope of this accreditation. Therefore, ensure that the
correct configuration is set if this level of FIPS secure operation is required.

The security mode flags set in FIPS 140 mode are shown in the table below.
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3 Setup and Configuration

Restricted Mode

The Restricted Mode security setting is a compromise between performance and security. If Restricted Mode is
selected, then the HSM will require all users to identify themselves before cryptographic services are available. This
mode also inhibits any clear PINs or sensitive key material from passing through the HSM’s PCle bus interface but
each individual request to the HSM does not need to be signed.

The security mode flags set in Restricted Mode are shown in the table below.

Security Mode Preconfigured Flag Settings

When the FIPS or Restricted security mode buttons are clicked in the Set Security — All Devices dialog box, the
status of the flags is changed as shown in the table below (default values). Those settings marked with an asterisk (*)
are mandatory in order to implement the requirements for the mode concerned. Additional flags, marked with a plus (+),
can be changed if required. See "Security Mode Flag Descriptions" below.

Flag FIPS 140 Mode Restricted Mode
Tamper Before Upgrade. Set* Cleared+
No Public Cryptography Set* Set*
Entrust Compliant Cleared*® Cleared*®
No Clear PINs Set* Set*
Authentication Protection Set* Cleared*
Lock Security Mode Set* Set*
Increased Security Mode Cleared+ Cleared+
Only Allow FIPS Approved Algorithms. Set* Cleared*
Full Secure Messaging Encryption Cleared+ Cleared+
Full Secure Messaging Signing Cleared+ Cleared*

Security Mode Flag Descriptions

Tamper Before Upgrade

When this flag is set, the HSM will automatically perform a soft tamper (erase all internal secure memory) as part of a
firmware upgrade, FM download, or FM disable operation.

No Public Cryptography
When this flag is set, no user can perform a cryptographic operation without having authenticated themselves.
When this flag is set, each token in the system will have the PKCS #11 CKF_LOGIN_REQUIRED flag set, to indicate

that applications must authenticate before operations. This security flag does not affect the Admin token, which always
requires authentication for use.

SafeNet ProtectToolkit User Guide
Release 5.3 007-013682-001 Rev. A December 2016 Copyright 2009-2016 Gemalto All rights reserved.



3 Setup and Configuration

@ Note: This setting does not impede the ability to perform RSA or other public key processing. It
ensures that crypto services cannot be performed by unauthenticated users.

Entrust Compliant

When this flag is set, Entrust Compliant Mode is operational, ensuring compatibility with the Entrust range of
applications. These applications require a specific security profile to operate correctly.

No Clear PINs

When this flag is set, no user PINs or other sensitive information may be passed across the host interface in an
unencrypted form. This enables secure messaging encryption between applications and the HSM. It will also disable
certain functions that would otherwise result in the clear transmission of sensitive data. This flag will also not allow any
keys to be created with the attribute CKA_SENSITIVE=FALSE.

Authentication Protection

This flag, when set, enforces secure messaging authentication between applications and the HSM. Each request to the
HSM must be digitally signed and will be verified by the HSM. The key used for this signing process is derived from a
key shared by the HSM and host application as well as the user PIN.

Applications will operate in a more secure manner with this flag set, but HSM performance will suffer due to the
additional operations required to sign each request and response message.

Lock Security Mode

The Lock Security Mode flag, when set, disables further modification of the security mode flag settings. Once set, this
flag (or any other security mode flag) cannot be modified. A new security mode can only be implemented after a tamper
operation is performed.

Increased Security Level

The Increased Security Level flag, when set, disables the mechanism CKM_EXTRACT_KEY_FROM_KEY and also
does not allow the CKA_MODIFIABLE attribute to be changed from False to True.

Only Allow FIPS Approved Algorithms

The Only Allow FIPS Approved Algorithms flag, when set, disables the following non-FIPS-approved algorithms: MD2,
MD5, RIPE, CAST, IDEA, RC2, RC4 and RC5.

Full Secure Messaging Encryption

The Full Secure Messaging Encryption flag is similar to the No Clear PINs flag, except that every message is
encrypted in both directions between the application and the HSM. The key used for the message encryption is
generated using the PKCS#3 Diffie-Hellman Key Agreement Standard.

This flag only performs two-way encryption when using the SafeNet ProtectToolkit-M client library in the client/server
mode over TCP/IP.

Applications will operate in a more secure manner with this flag set, but HSM performance will suffer due to the
additional operations required to sign each request and response message.
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Full Secure Messaging Signing

The Full Secure Messaging Encryption flag is similar to the Authentication Protection flag, except that every request in
both directions between the application and the HSM is digitally signed and verified. The key used for the message
encryption is generated using the PKCS#3 Diffie-Hellman Key Agreement Standard.

This flag only performs two-way encryption when using the SafeNet ProtectToolkit-M client library in the client/server
mode over TCP/IP. Applications will operate in a more secure manner with this flag set, but HSM performance will
suffer due to the additional operations required to sign each request and response message.

Allocating Keyset Space

In order for applications to use SafeNet ProtectToolkit-M's key storage facilities, keyset space must be allocated on the
HSM. Enough space should be allocated to accommodate the number of users requiring key storage.

Allocation of keyset space is the responsibility of the device administrator and is performed using the SafeNet
ProtectToolkit-M administration utility.

Note: It is important to determine how many key sets may be needed over time and to allocate
sufficient space so that additional key sets can be created without the need for a server
shutdown.

To allocate keyset space:

1. Launch the Administration Utility from the Start menu by selecting Start > Programs > SafeNet > ProtectToolkit
M > gtadmin.

2. Select the device on which to create keyset space from the Active Adapters list.
3. Openthe Adapter menu and choose Allocate Space.
The Administration Utility prompts for the device administrator password.

Following correct password entry, the new keyset space is displayed under the device as shown below.

— Active Adapters

-l Al
= device:0

48} MACHINE_K epset
SYSTEM_Feyzet

Creating User Keysets

A user keyset is required for each individual that will use the SafeNet ProtectToolkit-M system. The keysets are stored
on the HSM in available keyset spaces. This means that in order to create a user keyset, a free keyset space must be
available (see above).

Creating user keysets is the responsibility of the device administrator and is performed using the SafeNet
ProtectToolkit-M administration utility.
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Note: Ideally, all necessary keysets should be created prior to the system becoming

@ operational. If this is not feasible, it is important to estimate how many key sets may be needed
over time and to allocate sufficient space so that additional key sets can be created without the
need for a server shutdown.

To create a user keyset:
1. Launch the administration utility from the Start menu by selecting Start > Programs > SafeNet > ProtectToolkit
M > gmadmin.

2. Select the spare keyset space on which to create the keyset from the Active Adapters list.
3. Open the Keyset menu and choose Create Keyset.
The administration utility prompts for the Keyset Name and the Keyset Password.

4. Enter the required information into the fields provided and click OK to create the new keyset. Note that the name of
the keyset should match with the user login name. The new keyset displays under the device as shown below.

—Active Adapters
-l Al
=

ADMIMISTRATOR_Keyset
MACHIMNE_K.eyset
STSTEM_Kepset

Commencing Normal Operation

Following the above steps, SafeNet ProtectToolkit-M is ready for use. Additional configuration may be required in
certain circumstances, as covered in "Configuration Options" below.

The device administrator or user might need to perform various operational tasks during runtime usage. These tasks are
covered in the following chapters.

Configuration Options

Registry Configuration

Entries made in the Windows registry during the installation of SafeNet ProtectToolkit-M are documented in "Registry
Configuration" on page 101. These may be amended by expert users if required. Generally, the default values will not
need to be changed. The exceptions are the Debug Level and User Keyset Password entries used to control error log
file creation and silent user keyset login respectively. See the sections below for further information.

Error Log File Creation

The Debug Level registry key controls error log file creation. By default, the value of this key is set so that no error log
file is produced. Should it be necessary to create an error log file, see "debuglLevel" on page 102 for more options.

Silent User Keyset Login

While access to the Machine and System keysets is open, access to a User keyset requires authentication.
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Typically, User keyset access authentication is achieved by prompting the user for a password when access is
requested. This is not convenient/permissible in all situations, so silent user keyset login is also available.

To activate silent User keyset login:
Add the following value to the Windows registry:

HKEY CURRENT USER/Software/Safenet/ProtectToolkit M/
UserKeysetPassword=<password>

where <password> is the clear text password for the User keyset.

Since this value is located in the Current Users registry hive (which is only accessible/visible when a user
authenticates themselves to the Windows operating system) there is no security risk, even though the password is
stored in the clear.

Work Load Distribution (WLD)

If required, more than one hardware security module (HSM) can be used in a Work Load Distribution (WLD)
configuration.

WLD allows work to be balanced across a system by transferring units of work among HSM processing modules during
execution, reducing the demand on any particular processing module. This produces an increase in the system's overall
throughput of processing tasks. Using multiple HSMs in this way also provides redundancy. If an HSM goes down, the
work will automatically be shared amongst the remaining operational HSMs.

For further information, including implementation and maintenance instructions, refer to "Work Load Distribution" on
page 88.

KSP (for CNG) Configuration

The registration tool KspConfig.exe, installed by the 64-bit Client software installer into the C:\Program
Files\SafeNet\Protect Toolkit 5\KSP directory, registers HSM Partitions for use with CNG. It secures the Password
for each HSM Partition such that only the user for which the Password was secured is able to un-secure it.

1. Goto C:\Program Files\SafeNet\Protect Toolkit 5\KSP and launch KspConfig.exe (the KSP configuration
wizard).

2. Inthe left-hand pane (tree view) double-click "Register Or View Security Library"

In the right-hand pane, browse to the library C:\Program Files\SafeNet\Protect Toolkit 5\Protect Toolkit C
SDK\bin\hsm\cryptoki.dll and click Register.
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File Help

|

E1-SafeMet KSP Config
- Register Or View Security Library

LibraryPath |[G:\Program Files\SafeMet\Protect Toolkit 5\Protect Toolkit C SDKIbinvhs micryptoki.dil |

. Register HSM Slots

4. Return to the left-hand pane and double-click “Register HSM Slots” and click Next.

File Help

Register |

|

(=-Safelet KSP Config Register For User Domain

Reqister By

.. Register Or View Security Library

Register HSM Slots | Administrator j | WIN-BFI9SFMM20K

Available Slots Slot Password

j & Slot Label

[0 wLD_s1 ~|

|  Slot Number

Registered Slots

Register Slot

View Registered Slots

5. Inthe Slot Password field, type in the password for the indicated slot.

To the right of the window, click the “Register Slot” button.

Delete Registered Slot

[ M|
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File Help

|

- SafeMet KSP Config
..Register Or View Security Library
Register HSM Slots

Register For User Domain Register By
|ﬁ.dministratc|r | |WIN—EFIQSFMM3DK ~| | & siotLavel

Available Slots Slot Password

[o wLD_s1 o] [ |  Slot Number

Register Slot

View Registered Slots

Registered Slots

Delete Registered Slot

[ INm[

6. Return to the Domain pull-down list and select "NT AUTHORITY," supply the password for the slot being
registered, and again click “Register Slot” to complete the KSP configuration.

File Help

|

- SafeMet KSP Config
Register Or View Security Library
Register H5M Slots

Register For User Domain Register By
|SYSTEM | |NTAUTH0R|TY ~| | slotLabel
Available Slots Slot Password

[o wLp_s1 o] [ | | € SlotNumber

Register Slot

View Registered Slots

Registered Slots

Delete Registered Slot

_ Num[

Once you have the slots registered, you can begin connecting with your client application to perform crypto operations
in your HSM.

Configuring 11IS7 (Win2008) with CNG

This section describes how to configure Microsoft Internet Information Services 7 (11S7) on Windows Server 2008 for
use with CNG.
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To configure 11IS7 on Windows Server 2008 for use with CNG
1. Install and configure your HSM.
2. Install and configure KSP:

a. Register your cryptoki.dll file

File Help

|

- SafeMet KSP Config

Register Or View Security Library
. Register HSM Slots LibraryPath |G:\Program Files\SafeMetiProtect Toolkit 5\Protect Toolkit C SDK\binthsmicryptoki.dil |

Register |

File Help

|

- SafeMet KSP Config
..Register Or View Security Library

ini - - - G‘
MR qgister HSM Slots |Adm|mstrator | |WIN BFI9SFMM30K - Slot Label

Available Slots Slot Password

[0 wLD_s ~] |

Register For User Domain Register By

| ¢ Slot Number

Register Slot

View Registered Slots

Registered Slots

Delete Registered Slot

[ um |

3. Create apolicy file to generate a cert request. Normally, you can do this directly through the GUI, but the KSP is
not yet recognized through the GUI. The policy file (call it policy.inf) should look like this:

[New Request]
KeyUsageProperty = “NCRYPT ALLOW DECRYPT FLAG”
Providertype =1
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RequesterName = OTT1-HANNIBAL\Administrator

RequestType = PKCS10

ProviderName = “SafeNet Key Storage Provider”
Subject = “CN=OTT1-HANNIBAL, OU=Eng, O=SafeNet-Inc,

L=Ottawa, S=Ontario, C=CA”
KeyContainer = “OTT1-HANNIBAL”
MachineKeySet = true
HashAlgorithm = shal
KeyAlgorithm = RSA
KeyLength = 2048

4. Using the above file, create your cert request:

C:\>certreq -new policy.inf cert.req

your IS server.

6. Install the root certificate:

a. Open the root cert file and select “Install Certificate.”

b. Atthe Welcome screen, click Next.

Submit your cert request to a CA and obtain a signed cert, and the root cert of the CA. Move these certificates to

c. You'll need to specify the Certificate Store to be used. Select the “Place all certificates in the following store”
radio button, and click the “Browse...” button.

d. Inthe Select Certificate Store window that opens, put a check in the “Show physical stores” box, locate and
expand Trusted Root Certification Authorities and select “Local Computer” then click OK.

Select Certificate Store

Select the certificate store wou wank to use,

i | Registry

‘ Local Computer
“e | Smart Card

-] Persanal
=] Trusted Roat Certification Autharities

I show phesical skares

K, I Zancel |

i

+-—| Frternrise Triisk hd
1 | »

Open Server Manager and select “Add Roles” to install Web Server (11S). Configure to your needs, though the
default options will do for the purposes of this document.

When the installation is complete, expand the Roles tree from the left-hand pane, then expand Web Server (11S)

and select “Internet Information Services (11S) Manager,” then select the object name (most likely your server's

name) from the Connections pane, as shown below:
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Et Server Manager B[] E3
File  Action Wiew Help
= |5
i Server Manager (OTT1-HANMIBAL) Internet Information Services {(I15) Manager
= 5 Roles = = -
= 9 web Server (115) @ &y [ 93 » OTTL-HANNIEAL » ] &

% Inkernet Information Servic
i Features
i Diagnostics
Eﬁul Configuration

@3 OTTLHANNIBAL Home Aewons
==

Manage Server

23 Storage Group by:  Area =R | Roctol
B Start
115

@ Stop

n g - Wiew Application Pools

.13! 4 ] o

Authentication Compression Default Direckary V'ﬁtes R
Docurnent Browsing ,-@ Help
— " = Crline Help
&) k

Error Pages Handler HTTP Logging
Mappings Respo...

oA o G

MIME Types Modules Cukput Server
Caching Certificates
o
aty
worker
Processes

9. Under the Home pane, open Server Certificates, then select “Complete Certificate Request...” from the Actions
pane.

10. Complete the form that opens; select the path to your certificate and choose a friendly name for said certificate and
click OK:

Complete Certificate Request E E3 |

/] | Specify _Liertiﬁc:atJ} Authuritly RespunJ_E | | | |

gl | |

Complete a previously created certificale request by retrieving the: file that conzains the cert ficate
authority's response,

File name containing the carkification aithority's response:

|>¢:'|,certnew.u:er - |

Friendly name:;

Iu:uttl-krat-:usl

ok I Cancel
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11. The certificate list will then be populated by the certificate you specified:

| |
&1 |Server Certificates | |
= b

mmpen mmmme mmd eapam e me i e ———. = e ——— -
"Uise this Feature to reque;t and manage: certificates that the Web server can use —
with Web sibes configured for 55L,
Mame = | Issued To I Issued By
iotk1-kratos OTT1-KRATOS rnoonmonkey-C A

4| | i
E Features Wiew |. \5. Cantent Yiew ! | | | |

12. Under the Connections pane, expand the server hostname tree (in the example below, OTT1-HANNIBAL), then
expand the Sites tree, and select “Default Web Site”:
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Internet Information Services (IIS) Manager

M

@ b OTTI-HANNIBAL P Sikes P Default Web Site  »

|8

Sites

Qj Stark Page
= Hﬂ OTT1-HAMMIEAL (OTT1-HANNIBAL
Application Poals

=43 Defaulk Web Site

Group by: | Area

Authentication  Compression

Handler HTTP
Mappings Respo...
o
> @
Cutput S50 Settings
Caching

&k Default web Site Home
-

B

.ﬁ.
Default
Document;

y

Logaging

Directary
Erowsing

MIME Types

404

Error Pages

Madules bt

0 Explore

Edit Permissions. ..

Edit Site

i

[ Basic st

ings...

Wigw Yirtu

Wiew Applications

al Directaries

© Restart
B

B Start
B stop

Lirnits. ..

Manage Web Site )

Browse Web Site

Configure

13. Select “Bindings” from the Actions pane on the right-hand side. This opens the Site Bindings box.

Type | Hosk Mame | Port: | IP Address | Bind
http &0 *
1| | i

14. Click Add, and make the following selections:

add...
Edit...
Remove

Erowse

Close

il

Type https

IP Address Can be left as “All unassigned”

Port Canbe left as 443

SSL Select the friendly name you assigned earlier to your certificate when your completed the cert
certificate request.

SafeNet ProtectToolkit User Guide
Release 5.3 007-013682-001 Rev. A December 2016 Copyright 2009-2016 Gemalto All rights reserved.

30



3 Setup and Configuration

Add Site Binding |

Type: IP address: Paort;
Ihttps j IF'.II Unassigned j I443
Hosk narme:

53L certificate:

okk1-hannibal

Click OK to continue.

15. Under the actions pane, you will now have a link labeled “Browse *:443 (https)” (this may appear slightly different,
depending on the IP Address options you set in the previous step).

Manage Web 5Site ~

~ Restart
Skark
B stop

Browse Web Site
@ | Browse *:80 (htkp)

@ | Browse *:443 (https)

......

Advanced Settings. ..

Configure

Lirnits. ..

W Help

Cnline Help

16. Select this link and it will show you your default webpage over a secure connection. Configure your website as
needed.
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Administrative Tasks

This section describes the operational procedures a device administrator may perform during normal SafeNet
ProtectToolkit-M operation. It contains:

"Changing the Device Administrator Password" below
"Allocating Keyset Space" on the next page
"De-allocating Keyset Space" on the next page
"Creating User Keysets" on page 34

"Deleting a Keyset" on page 34

"Setting the Adapter Transport Mode" on page 35
"Correcting Clock Drift " on page 36

"Viewing and Purging the HSM Event Log" on page 36
"Checking and Upgrading HSM Firmware" on page 37
"Tampering the HSM" on page 38

"Backing up a Keyset" on page 38

"Restoring a Keyset" on page 40

"Enabling Private Key Clear Export" on page 41

Changing the Device Administrator Password

The device administrator can perform a password change at any time and on any token.

Changing the device administrator password may only be performed by the device administrator, using the SafeNet
ProtectToolkit-M administration utility.

To change the device administrator password:
Launch the administration utility from the Start menu by selecting Start > Programs > SafeNet > ProtectToolkit

1.

M > gmadmin.

Select the device on which to change the device administrator password from the Active Adapters list.

Open the Adapter menu and choose Change Device Admin Password.

The administration utility will now prompt for the current and new device administrator password.

Note: Any existing backups of the MACHINE and SYSTEM keysets will no longer be useful
following a device administrator password change, because the backup key is generated from
the password. New backups must be created after changing the password.
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Allocating Keyset Space

When additional user keysets are required, the system will need to be configured for additional keyset space. The
number of allocated keyset spaces determines how many separate SafeNet ProtectToolkit-M users, and keysets, the
system can have.

Allocation of keyset space is the responsibility of the device administrator and is performed using the SafeNet
ProtectToolkit-M administration utility.

To allocate keyset space:

1. Ifitis not already open, launch the administration utility from the Start menu by selecting Start > Programs >
SafeNet > ProtectToolkit M > gmadmin.

Select the device on which to create keyset space from the Active Adapters list.
Open the Adapter menu and select Allocate Space.

The administration utility will now prompt for the device administrator password.

o A w N

Following correct password entry, the new keyset space will be displayed under the device.

Note: Additional keyset space cannot be allocated if an application is currently using SafeNet
ProtectToolkit-M. See Session Exists Errorin "Known Issues" on page 77.

To check if an application has any open sessions to SafeNet ProtectToolkit-M, check the value shown next to
Application Count in the System section of the administration utility. This will need to be “1”, and the Total Session
Count must be “0” in order for keyset de-allocation to succeed.

Note: If the value of Application Count is shown as “UNAVAILABLE”, your HSM firmware

@ doesn’t support live application counting. In such a case, it is advisable to upgrade the HSM
firmware to the latest version. Please refer to "Checking and Upgrading HSM Firmware" on
page 37.

De-allocating Keyset Space

If there are keyset spaces which are not likely to be used, it is good practice to de-allocate spare spaces from the HSM
in order to prevent memory exhaustion or invalid use.

De-allocation of keyset space is the responsibility of the device administrator and is performed using the SafeNet
ProtectToolkit-M administration utility.

To de-allocate keyset space:

1. Launch the administration utility from the Start menu by selecting Start > Programs > SafeNet > ProtectToolkit
M > gmadmin.

Select any spare space from the Active Adapters list.
Open the Keyset menu and choose Deallocate Space.

The administration utility will now prompt for the device administrator password.

o b~ w N

Following correct password entry, the spare keyset space will be removed from the list of displayed keysets.
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Note: Keyset space cannot be de-allocated if an application is currently using SafeNet
ProtectToolkit-M. See Session Exists Errorin "Known Issues" on page 77.

To check if an application has any open sessions to SafeNet ProtectToolkit-M, check the value shown next to
Application Count in the System section of the administration utility. This will need to be “1”, and the Total Session
Count must be “0” in order for keyset de-allocation to succeed.

Note: If the value of Application Count is shown as “UNAVAILABLE”, your HSM firmware

@ doesn’'t support live application counting. In such a case, it is advisable to upgrade the HSM
firmware to the latest version. Please refer to "Checking and Upgrading HSM Firmware" on
page 37.

Creating User Keysets

In order to create a new keyset for a specific user, you will first have to make sure that there is spare keyset space
available on the HSM. This can be done by opening the SafeNet ProtectToolkit-M administration utility.

Should no spare space be available, you will have to allocate additional keyset space on the HSM. For details, please
refer to the appropriate section above.

@ Note: Users can create keysets for themselves once space is available.

To create a user keyset:

1. Launch the administration utility from the Start menu by selecting Start > Programs > SafeNet > ProtectToolkit
M > gmadmin.

2. Select the spare keyset space on which to create the keyset from the Active Adapters list.
Open the Keyset menu and choose “Create Keyset.”

4. The administration utility will now prompt for the Keyset Name and the Keyset Password. Enter the required
information into the fields provided and press OK to create the new keyset.

@ Note: The name of the keyset should match with the user login name.

The new keyset is displayed under the device.

Deleting a Keyset

Deleting user keysets is the responsibility of the device administrator and is performed using the SafeNet
ProtectToolkit-M administration utility.

To delete a user keyset:

1. Launch the administration utility from the Start menu by selecting Start > Programs > SafeNet > ProtectToolkit
M > gmadmin.

2. Select the desired keyset from the Active Adapters list.

Open the Keyset menu and choose Delete Keyset.
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4. The administration utility will now prompt for the device administrator Password. Prior to deletion, the
administration utility will prompt for confirmation that deletion is the requested operation.

5. The keyset is removed from the displayed keysets under the selected device.

Note: A keyset cannot be deleted if an application is currently using SafeNet ProtectToolkit-M.
See Session Exists Errorin "Known Issues" on page 77.

To check if an application has any open sessions to SafeNet ProtectToolkit-M, check the value shown next to
Application Count in the System section of the administration utility. This will need to be “1”, and the Total Session
Count must be “0” in order for the keyset deletion to succeed.

Note: If the value of Application Count is shown as “UNAVAILABLE”, your HSM firmware

@ doesn’t support live application counting. In such a case, it is advisable to upgrade the HSM
firmware to the latest version. Please refer to "Checking and Upgrading HSM Firmware" on
page 37.

Setting the Adapter Transport Mode

The adapter transport mode allows an adapter HSM to be removed from the host system PCI bus without causing a
tamper condition. A tamper will remove all sensitive material from the adapte,r including the adapter configuration, all
keys, and certificates.

Setting the adapter transport mode is the responsibility of the device administrator and is performed using the SafeNet
ProtectToolkit-M administration utility.

To set the adapter transport mode:

1. Launch the administration utility from the Start menu by selecting Start > Programs > SafeNet > ProtectToolkit
M > gmadmin.

2. Select the desired adapter from the Active Adapters list.
Open the Adapter menu and choose Set Transport Mode.
4. The device administrator is now prompted to choose one of three possible transport modes:

None: To be applied when adapter is installed and configured. This mode will tamper the adapter if removed from
the PCle Bus.

Single -Adapter: Will not be tampered after removal from the PCle bus. Adapter will automatically change to
“None” Transport Mode the next time the adapter is reset or power is removed and restored.

Continuous -Adapter: Will not be tampered by being removed from the PCle bus.

5. The administration utility will now prompt for the device administrator password.

@ Note: The transport mode does not disable the tamper response mechanism entirely. Any
attempt to physically attack the adapter will still result in a tamper response.
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Correcting Clock Drift

Due to host system and HSM timing differences, such as clock drifts, it may become necessary, at certain stages, to
adjust the internal time on the HSM.

Note that the HSM clock value cannot be specified directly. It is only possible to synchronize the HSM clock with the
host system clock.

Synchronizing the HSM clock is the responsibility of the device administrator and is performed using the SafeNet
ProtectToolkit-M administration utility.

To adjust the HSM clock:

1. Launch the administration utility from the Start menu by selecting Start > Programs > SafeNet > ProtectToolkit
M > gmadmin.

2. Select the desired HSM from the Active Adapters list.
Open the Adapter menu and choose Sync Clock.

4. The administration utility will now prompt for the device administrator password. Correct entry of the password will
result in clock synchronization.

Viewing and Purging the HSM Event Log

SafeNet ProtectServer HSMs maintain event logs in order to provide a means of tracking serious hardware or
consistent operational faults. It is the device administrator’s task to view and purge HSM event log data. For full details
on what the event log stores and how to interpret its data, please refer to "Event Log Error Types" on page 105.

When the HSM event log is full, the HSM will no longer store new event records and will need to be purged.

@ Note: The HSM event log cannot be purged until it is full.

To view the HSM event log:

1. Launch the administration utility from the Start menu by selecting Start > Programs > SafeNet > ProtectToolkit
M > gmadmin.

2. Select the desired HSM from the Active Adapters list.
Open the Adapter menu and select View Event Log.

4. The administration utility will now prompt for the device administrator password. Correct entry of the password will
result in the event log being displayed.

5. Theeventlogis shown as a series of pages. If there are more than one page of event log entries, the operator can
navigate through the pages via the first, prev, next, last buttons.

To purge the event log:
1. Launch the administration utility from the Start menu by selecting Start > Programs > SafeNet > ProtectToolkit
M > gmadmin.

2. Select the desired HSM from the Active Adapters list.
Open the Adapter menu and choose Purge Event Log.

4. The administration utility will now prompt for the device administrator password. Correct entry of the password will
result in the event log being purged.
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@ Note: The event log can also be purged via the View Event Log dialog by clicking the Purge
button.

Checking and Upgrading HSM Firmware

The SafeNet ProtectToolkit-M firmware that operates on the HSM can be upgraded to newer versions. This facility will
only allow the HSM to be upgraded to firmware versions that have been digitally signed by SafeNet.

The firmware update package, formerly supplied identically on both the SafeNet ProtectToolkit-C and SafeNet
ProtectToolkit-M DVDs, is now available only from the Gemalto eService Support Portal, along with a specific Update
instruction document. The instructions in this section are generic in nature, intended only to show the scope of the
operation. The authoritative, detailed instructions are always in the Update document that accompanies the update
package. The latest versions of the client software and HSM firmware can be found on the Gemalto eService Support
Portal at https://serviceportal.safenet-inc.com.

Prior to performing a firmware upgrade, the firmware upgrade file should be checked to confirm that it is a valid SafeNet
upgrade file.

Depending on the security policy in place, the HSM may perform a soft-tamper before the upgrade process is executed.
This tamper will erase all key and configuration data on the HSM. Prior to performing a firmware upgrade, ensure that
you have performed the following:

e Allimportant user data and keys have been backed up
¢ The current HSM configuration has been noted

e All applications using the HSM have been closed — this may require some services to be stopped (e.g. Certificate
Services, IIS)

Upgrading the HSM firmware is the responsibility of the device administrator and is performed using the SafeNet
ProtectToolkit-M administration utility.

To check the firmware upgrade file:

1. Ifitis not already open, launch the administration utility from the Start menu by selecting Start > Programs >
SafeNet > ProtectToolkit M > gmadmin.

2. Select the desired HSM from the Active Adapters list.

3. Open the Adapter menu and choose Check Firmware File.

4. The administration utility will now prompt for the location of the firmware upgrade file.
5

The utility will show if the file is validated, or corrupt.

To upgrade the HSM firmware:

1. Ifitis not already open, launch the administration utility from the Start menu by selecting Start > Programs >
SafeNet > ProtectToolkit M > gmadmin.

Select the desired HSM from the Active Adapters list.
Open the Adapter menu and choose Upgrade Firmware.

The administration utility will now prompt for the location of the firmware upgrade file.

o M w DN

If the file is validated, the utility will prompt for the device administrator password. Correct password entry will
proceed with the firmware upgrade.
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Note: During the firmware upgrade the administration utility will appear to stop functioning.

@ This is normal since firmware upgrades can take up to 40 seconds to complete. If the utility
does not respond after a number of minutes, shut down your system and reboot. If problems
persist, see "Support Contacts" on page 10 to contact SafeNet technical support.

Tampering the HSM

The tampering of the HSM may be necessary at the end of its lifecycle or any other security-sensitive event that
requires all stored data to be immediately destroyed.

A tamper formats the secure memory of the HSM and thereby erases all configuration and key data.

Due to the highly destructive nature of this action, tampering the HSM is the responsibility of the device administrator
and is performed using the SafeNet ProtectToolkit-M administration utility. Note that this action also requires that all
sessions have been closed and that no user is accessing the HSM.

To tamper the HSM:

1. Launch the administration utility from the Start menu by selecting Start > Programs > SafeNet > ProtectToolkit
M > gmadmin.

2. Select the desired HSM from the Active Adapters list.
Open the Adapter menu and choose Tamper.

4. The administration utility will now prompt for the device administrator password. Correct entry of the password will
show a final confirmation dialog to ensure that this is the desired course of action.

5. Press Yes to tamper the HSM, or No to Cancel.

Note: The above action cannot tamper the HSM while other applications are active. The
administration utility will indicate if the tamper operation was successful. A white cross on ared
background shown next to the selected HSM indicates that the device is tampered.

Backing up a Keyset

Individual, HSM stored keysets can be backed up to a secure disk file or one or more smart cards. Backed up keysets
can then be restored in the event of a tamper to the HSM or if the keysets are otherwise lost.

Note: Users are responsible for backing up their own keysets and the SafeNet ProtectToolkit-
M device administrator is responsible for backing up the MACHINE and SYSTEM keysets.

A triple-DES BackupKey is used to encrypt each keyset prior to storage on a smart card. A different BackupKey is
automatically created for each keyset when the keysets are created but these keys are not visible under normal
SafeNet ProtectToolkit-M operation. A BackupKey for a keyset is derived from a combination of the password used to
secure that particular keyset and the keyset name. In the case of the MACHINE and SYSTEM keysets, the device
administrator's password and the keyset name are used to derive the key. Thus to restore a keyset that was previously
backed up, the same password and keyset name must be used.

Keyset backup and restore is accomplished with the command line utility ctkmu. Please refer to for the complete
ctkmu reference.
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Preparation

Prior to attempting a keyset backup, please ensure that you have:

* avalid keyset that can be backed up

e if backing up to smart cards, a smart card reader connected to the HSM, and

e sufficient smart cards or disk space to back up the required data.

Procedure

1. Obtain a listing of all keysets by executing ctkmu | from a command prompt.

B Administrator: Command Prompt | = | O] -

C:\>ctkmu 1
ProtectToolkit C Key Management Utility 5.3.0
Copyright (c¢) Safenet, Inc. 2009-2016

| »

Icryptoki Uersion 2.20
Safenet, Inc.

USER_03_Keyset
USER_04_Keyset
AdminToken (518687)

C:\>.

2. Record the slot number for the keyset you wish to backup.

3. Tobackup a keyset to afile, from a command prompt, type the following, substituting the slot number of the keyset
to backup for n and the name of the file to back up to for fileName:

ctkmu x —-sn —-wBackupKey filename

Note: When backing up the MACHINE_Keyset orthe SYSTEM_Keyset, enter the default
value password as the user password. The device administrator's password and the keyset
name will be used to derive the BackupKey in these instances.

Example

In the example below, the keyset on slot 0 will be securely encrypted using the key BackupKey (created from the user
password for the keyset and the keyset name) and backed up to the disk file named MachineKeyset.bak. This
operation will prompt for the user password for the keyset.

ctkmu x -s0 -wBackupKey MachineKeyset.bak
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B Administrator: Command Prompt |5‘E|d—hj

C:\>ctkmu x -s2 -wBackupKey MachineKeyset.bak
ProtectToolkit C Key Management Utility 5.3.0
Copyright (c) Safenet, Inc. 2009-2018

m »

JEnter user PIN for slot 2:

SUCCEEDED
SUCCEEDED

Keyset_01_01_Exchange SUCCEEDED

C:\>.

Restoring a Keyset

Precautions
* Torestore akey that was previously backed up, the same password and keyset name must be used.

e Extreme care should be taken to ensure that keys which are being restored DO NOT already exist on the SafeNet
ProtectToolkit-M system. A restore operation DOES NOT replace existing keys, but will restore a second instance
of the same key pair. If you have accidentally created multiple instances of the same key pair, SafeNet
ProtectToolkit-M will mark the affected keyset as being invalid. Please refer to "Known Issues" on page 77 for
details on how to address this type of problem.

To restore a keyset:

1. Create a new keyset with the same name and password as the original. See the section in "Setup and
Configuration" on page 16 for the procedure.

2. Torestore akeyset from file, from a command prompt type the following, substituting the slot number of the keyset
to restore for n and the name of the file containing the keyset for fileName.

ctkmu i -sn -wBackupKey filename

Note: When restoring the MACHINE_Keyset or the SYSTEM_Keyset, enter the default value
password as the user password. The device administrator password used to create the backup
will also be prompted for.

Example

The example below will import a keyset to the token in slot 0 from a disk file named MachineKeyset.bak and unwrap,
or decrypt, the data with the key which has a label of BackupKey. This operation will prompt for the user password for
the keyset.

ctkmu i -s0 -wBackupKey MachineKeyset.bak
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Enabling Private Key Clear Export

In order to support the key archival process, it must be possible for the host machine to obtain the value of the private
key in the clear.

Due to the inherent security risks, the Allow Clear Export of Private Keys flag controls whether this value can be
obtained. This is a “secure configuration item”.

A secure configuration item is one which is open for reading, but requires authentication for writing. Such configuration
items are stored on the HSM and protected by the password of the device administrator.

If Allow Clear Export of Private Keys flag is set to True, then it is possible to obtain the value of a private key in the
clear using the Microsoft Crypto API (MSCAPI) (causing the key archival process to succeed).

If Allow Clear Export of Private Keys is set to False, then any requests to obtain the value of a private key in the clear
are denied (causing the key archival process to fail).

The value of the Allow Clear Export of Private Keys flag can be changed using the SafeNet ProtectToolkit-M
Administration Utility.

To set or clear the Allow Clear Export of Private Keys flag:

1. Launch the administration utility from the Start menu by selecting Start > Programs > SafeNet > ProtectToolkit
M > gmadmin.

2. Select the desired HSM from the Active Adapters list.
3. Open the Adapter menu and choose Set Secure Configuration. The Set Secure Configuration dialog box
displays.

fa Set Secure Configuration - Device O x|

— Secure Configuration

[~ Allaw Clear Export of Private Keys

Ok,

4. Set orclear the Allow Clear Export of Private Keys flag as required, then click OK to action the change.
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User Tasks

This section describes the operational procedures a User may perform during normal SafeNet ProtectToolkit-M
operation. It contains sections on the following operations:

e "Creating Keysets" below

e "Changing a Keyset Password" below

e "Adding a Key Container" on the next page

* "Removing a Key Container" on the next page

* "Generating a Key Pair" on the next page

e "Deleting a Key Pair" on page 44

» "Displaying Key Pair Properties" on page 45

* "Backing up and Restoring Keysets" on page 45

Creating Keysets

To create a new keyset, first ensure that there is enough keyset space available on the HSM. This can be confirmed by
opening the SafeNet ProtectToolkit-M Administration Utility.

If there is not enough space available, an administrator will have to allocate additional keyset space on the HSM. For
details please refer to the previous chapter.

To create a keyset:

1. Launch the administration utility from the Start menu by selecting Start > Programs > SafeNet > ProtectToolkit
M > gmadmin.

2. Select the spare keyset space on which to create the keyset from the Active Adapters list.
Open the Keyset menu and choose Create Keyset.

4. The administration utility now prompts for the Keyset Name and the Keyset Password. Enter the required
information into the fields provided and press OK to create the new keyset.

@ Note: The name of the keyset should match with the user login name.

5. The new keyset is displayed under the device.

Changing a Keyset Password

A keyset password may need to be changed periodically. A keyset password is changed by the keyset owner, using
the SafeNet ProtectToolkit-M keyset management utility.
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To change the keyset password:

1. Launch the keyset management utility from the Start menu by selecting Start > Programs > SafeNet >
ProtectToolkit M > gmksm.

2. From the displayed list, select the desired keyset.
Open the Keyset menu and choose Change Password.

4. The useris prompted for the current and new keyset password. Enter the required information into the fields
provided and press OK to change the password.

Note: Any existing keyset backups will no longer be useful following a keyset password
change, because the backup key is generated from the password. New backups should be
created after changing the password.

Adding a Key Container

Key containers are created within a user’s keyset, so that the keyset can hold key pairs. The keyset owner can add a
key container using the SafeNet ProtectToolkit-M keyset management utility.

To add a key container:

1. Launch the keyset management utility from the Start menu by selecting Start > Programs > SafeNet >
ProtectToolkit M > gmksm.

2. From the displayed list, select the desired keyset.
Open the Keyset menu and choose Add Container.

4. The useris prompted for the keyset password and key container name. Enter the required information into the fields
provided and press OK to create the key container.

Removing a Key Container

Key containers which are no longer required or hold obsolete key pairs may be removed from a keyset.

Removing a key container is performed by the keyset owner, using the SafeNet ProtectToolkit-M keyset management
utility.

To remove a key container:

1. Ifitis not already open, launch the keyset management utility from the Start menu by selecting Start > Programs
> SafeNet > ProtectToolkit M > gmksm.

2. Select the keyset container which you wish to remove.
Open the Keyset menu and choose Remove.

4. The useris prompted for the keyset password and confirmation that the container removal is the required action.
Press OK to remove the key container.

Generating a Key Pair

Key pairs are used by Crypto API to encrypt or sign data. There are two types of key pairs, and they must be created
inside a key container. Please refer to "Adding a Key Container" above.
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The keyset owner can generate a key pair using the SafeNet ProtectToolkit-M keyset utility.

To generate a key pair:

1. Launch the keyset management utility from the Start menu by selecting Start > Programs > SafeNet >
ProtectToolkit M > gmksm.

2. Select the keyset container in which to generate a key pair.

Open the Container menu and choose Generate Key Pair.

4. The useris prompted to enter the keyset password. Correct password entry will display the generate key pair
dialog.

5. The generate key pair dialog will prompt for the key usage and key size.

6. Choose Exchange or Sign depending on the required key pair usage.

7. Select a Key Size from the drop-down list.

8. Check the Exportable checkbox if you want to be able to back up this key pair.

9. Press OK to generate the key pair.

Key Usage

Key pairs generated using the keyset management utility have one of two usage attributes. These are:

»  Exchange: This type of key pair is used to encrypt session keys for the user during normal SafeNet ProtectToolkit-
M operation.

e Sign: This type of key pair is used to create digital signatures for the user during normal SafeNet ProtectToolkit-M
operation.

Each user will generally require both types of keys within their particular keyset.

Key Size

Key size is an important consideration when using encryption as a security measure. When discussing key size, the
value is given as a bit length, referring to how many digits are represented in the key value. As a general guideline,
longer bit lengths produce longer keys and more secure encryption. However, larger key sizes slow the encryption
process, due to the larger calculations involved.

Deleting a Key Pair

The keyset owner can delete a key pair using the SafeNet ProtectToolkit-M keyset management utility.

To delete a key pair:

1. launch the keyset management utility from the Start menu by selecting Start > Programs > SafeNet >
ProtectToolkit M > gmksm.

2. Select the key pair you wish to delete.
Open the KeyPair menu and choose Delete.

4. The useris prompted to enter the keyset password. Correct password entry deletes the selected key pair.
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Displaying Key Pair Properties

Key pair properties can be displayed by any user of the SafeNet ProtectToolkit-M keyset management utility.

To display the properties of a key pair:

1. Launch the keyset management utility from the Start menu by selecting Start > Programs > SafeNet >
ProtectToolkit M > gmksm.

2. Select the key pair for which to display its properties.

3. Open the KeyPair menu and choose Properties.

Information shown includes the following:

* Keyset: Displays the name of the keyset on which the selected key pair resides.

e Container. Displays the name of the key container in which the selected key pair resides.

* Usage: Shows the key usage attribute of the selected key pair. This value will either be “EXCHANGE” or “STGN”.
e Size: Shows the key size for the selected key pair.

* Private Key Held: This indicates if the private key for the selected key pair is present as part of the key pair. Since it
is possible to import a public key only, this value will either be “TRUE” or “FALSE”.

*  Exportable: Indicates whether the selected key pair can be backed up.

Backing up and Restoring Keysets

Users are responsible for backing up their own keysets. The procedures involved in backing up and restoring key pairs
or keysets are detailed in "Administrative Tasks" on page 32

* "Backing up a Keyset" on page 38
* "Restoring a Keyset" on page 40

Keyset backup or restore operations should not be attempted without thorough knowledge of the procedure and the
possible consequences of incorrect actions. It is strongly advised that the device administrator is consulted prior to
performing a keyset backup or restore operation.
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Administration and User Utilities

This section outlines the following utilities:

"Administration Utility" below

"Keyset Management Utility" on page 53
"CTKMU" on page 57

"CREATECERT Utility" on page 64

Administration Utility

The administration utility (gmadmin) is designed exclusively for use by the SafeNet ProtectToolkit-M device
administrator, and allows the following operations:

Initialization of HSMs

Synchronization of HSM clock with the system clock
Setting of the adapter transport mode

Setting security flags

Changing of the SafeNet ProtectToolkit-M device administrator password
Upgrade of the HSM firmware

Allocation of keyset space

De-allocation of keyset space

Creation of keysets

Deletion of keysets

Viewing the HSM event log

Purging the HSM event log

Tampering the HSM

Please note that this section is only intended as a reference for the administration utility. When performing
administrative tasks, the reader is strongly advised to refer to "Administrative Tasks" on page 32 for details regarding
each task.
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Figure 1: Administration Utility User Interface
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Starting and Exiting the Administration Utility

To start the administration utility, select Start > Programs > SafeNet > ProtectToolkit M > gmadmin. After an initial

splash screen, the main user interface is shown.

To exit the utility, select Exit from the File menu.

User Interface

The administration utility is presented as a Graphical User Interface (GUI), which is divided into three main areas.

These are:

¢ The Menu Bar — shown along the top of the utility. All available utility commands can be activated via these

menus.

e The Active Adapters display pane — shows all hardware HSMs found on the host system and their associated
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keysets. These are represented as a hierarchical tree view, with HSMs being the highest member and keysets or
keyset spaces shown beneath each HSM.

¢ The Details pane — broken up into two sub-groups and displays the following information.

Adapter Details

Initialized

Shows whether the currently selected HSM has been initialized. Values are either TRUE or
FALSE.

Serial Number

The serial number of the selected HSM.

Battery Status

Indicates the charge of the onboard battery of the selected HSM. This may either be GOOD or
LOW. If this indicates LOW, the selected HSM may not be able to retain stored key
information in the event of a system power failure. The HSM should be returned to your
nearest SafeNet service centre for battery replacement. See "Support Contacts" on page 10.

Board Revision

Shows the hardware revision of the currently selected HSM.

Firmware Revision

Shows the firmware revision of the currently selected HSM.

Cprov Revision

Shows the revision of SafeNet ProtectToolkit-C found on the currently selected HSM. This is
a software component which forms part of the HSM firmware. This value may need to be
quoted when contacting SafeNet support.

Transport Mode Shows the transport mode which is set for the currently selected HSM. This value will be
either “None”, “Single”, or “Continuous”. Refer below for details.

Clock (GMT) Shows date and time (GMT) on the currently selected HSM.

Clock (local) Shows the local date and time on the currently selected HSM.

Event Log Count Gives a total for the number of event log entries on the currently selected HSM.

Event Log Full Shows if the event log is full and needs purging. This value may be either “FALSE”, indicating

that there is available space in the log, or “TRUE”, indicating that the log is full.

System Details

Application Count

Shows the number of applications which are currently accessing the SafeNet ProtectToolkit-
M system. This value may show as “UNAVAILABLE” which denotes that the firmware on the
selected HSM does not support application counting.

Total Session Count

Shows the number of open sessions to the SafeNet ProtectToolkit-M system.

Password Entry Dialog Boxes

Most actions performed within the administration utility will require entry of the device administrator password. The
device administrator password is case-sensitive and may consist of any alphanumeric characters, between 4 and 32

characters in length.
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Figure 1: Device administrator password entry dialog box
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Keep Password Feature

The utility can remember the device administrator password for the duration of the session. This eliminates the need to
repeatedly enter the password for multiple operations.

To enable this feature, check the box next to Keep Password For Session when entering the device administrator
password.

CAUTION: When this feature is enabled, take care not to leave the administration utility
unattended. To ensure that unauthorized people do not obtain management access to HSMs,
close the administration utility once you have finished with your task.

Keyboard Shortcuts

All available menu items may be activated via keyboard shortcuts. The menu bar can be selected by pressing the [Alf]
key. Commands may then be selected by pressing the first unique letter of the required command. For example: [Alf]
followed by [A] will open the Adapter menu.

There are also a number of key combination shortcuts which will immediately activate a command:
* CTRL+I = Initialize HSM

e CTRL+A = Allocate Keyset Space

* CTRL+V = View Event Log

e CTRL+P = Change Admin Password

* CTRL+U = Upgrade Firmware

e CTRL+T = Tamper HSM

e CTRL+D = De-allocate Space

* CTRL+K = Create Keyset

Context Menus

Right-clicking on an item in the Active Adapters display pane will bring up a context menu showing available
commands specific to that item.

For details about these commands, please refer to the section appropriate to the menu in question.
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All Adapters Menu

The All Adapters menu is only available if there is more than one HSM installed on the system. This menu allows the
device administrator to affect all installed HSMs with a single command. The following actions can be performed via
this menu:

Initialize Adapters
This option initializes all uninitialized HSMs found on the system. Only initialized HSMs can store key information.

Synchronize Clocks
This option synchronizes all HSMs found on the system with the value of the host system clock.

Set Transport Modes

This option sets the adapter transport mode for all adapters found on the system. The adapter transport mode allows an
HSM to be removed from the host system's PCle bus without causing a tamper condition. A tamper will remove all
sensitive material from the adapter, including the adapter configuration, keys, and certificates.

The device administrator is prompted to choose one of three possible transport modes:

¢ None - To be applied when adapter is installed and configured. This mode will tamper the adapter if removed from
the PCle bus.

¢ Single - Adapter will not be tampered after its next removal from the PCle bus. Adapter will automatically change
transport mode to None the next time the adapter is reset or power is removed and restored.

¢ Continuous - Adapter will not be tampered by being removed from the PCle bus.

Set Security Flags

This option allows the setting of a security mode using security flags. These flags affect both the services available to
the various users of the system, as well as specific security features of the HSM. The flags may be specified
individually to set a custom security mode, but a standard security mode is recommended. When a standard security
mode is selected, the flags are assigned values automatically to meet the requirements for that mode. For further
information see "Initial Configuration: Mandatory Steps" on page 17, "Security Mode Descriptions" on page 18, and
"Security Mode Flag Descriptions" on page 19.

Set Secure Configuration
This option allows secure configuration items to be set.

A secure configuration item is one that is open for reading but requires authentication for writing. Such configuration
items are stored on the HSM, protected by the password of the device administrator.

A single item is currently supported - Allow Clear Export of Private Keys. See "Enabling Private Key Clear Export" on
page 41 .

Set Admin Passwords
This option changes the current device administrator password for all HSMs on the host system.
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Upgrade Firmware

This option performs a firmware upgrade for all HSMs on the host system. The device administrator is prompted to
enter the path to the firmware update file.

Tamper All Adapters

This option causes a tamper of all HSMs found on the system. A tamper formats the secure memory of the HSM and
thereby erases all configuration and key data.

Adapter Menu

The Adapters menu is used to perform the following administrative actions on a selected HSM:

Initialize
This option initializes the selected HSM. Only initialized HSMs can store key information.

Allocate Space
This option allocates one keyset space on the selected HSM. Keyset space is required to create user keysets.

View Event Log

This option opens the event log viewer. The dialog shows event log entries in chronological order, with the most current
event showing last. The first, prev, next and last buttons can be used to navigate through the event details, should
there be more than one page of entries.

If the event log is full, it can be purged by clicking the Purge button.

@ Note: The Purge button is disabled until the event log is full.

Purge Event Log
This option purges the event log.

@ Note: This menu option is disabled until the event log is full.

Synchronize Clock
This menu option synchronizes the clock of the selected HSM with the host system clock.

Set Transport Mode

This menu option is used to set the adapter transport mode for the selected adapter. The adapter transport mode allows
an HSM to be removed from the host system's PCle bus without causing a tamper condition. A tamper will remove all
sensitive material from the adapter, including the adapter configuration, keys, and certificates.

The device administrator is prompted to choose one of three possible transport modes:

¢ None - To be applied when adapter is installed and configured. This mode will tamper the adapter if removed from
the PCle bus.
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¢ Single - Adapter will not be tampered after its next removal from the PCle bus. Adapter will automatically change
transport mode to None the next time the adapter is reset or power is removed and restored.

¢ Continuous - Adapter will not be tampered by being removed from the PCle bus.

Change Admin Password
This option changes the device administrator password for the currently selected HSM.

Upgrade Firmware

This option performs a firmware upgrade for the selected HSM. The device administrator is prompted to enter the path
to the firmware update file.

Check Firmware Upgrade File

This option is used to check the validity of a firmware upgrade file. The device administrator is prompted to enter the
path to the firmware update file.

Tamper

This option causes a tamper of the selected HSM. A tamper formats the secure memory of the HSM, erasing all
configuration and key data.

Set Security Flags

This option allows the setting of a security mode using security flags. These flags affect both the services available to
the various users of the system, as well as specific security features of the HSM. The flags may be specified
individually to set a custom security mode, but a standard security mode is recommended. When a standard security
mode is selected, the flags are assigned values automatically to meet the requirements for that mode. For further
information see "Initial Configuration: Mandatory Steps" on page 17, "Security Mode Descriptions" on page 18, and
"Security Mode Flag Descriptions" on page 19.

Set Secure configuration
This menu option allows the setting of security configuration items.

A secure configuration item is one that is open for reading but requires authentication for writing. Such configuration
items are stored on the HSM, protected by the password of the device administrator.

A single item is currently supported - Allow Clear Export of Private Keys. See "Enabling Private Key Clear Export" on
page 41.

Keyset Menu

The Keyset menu is used to perform the following administrative actions on a selected keyset:

Delete
This option will delete the currently selected keyset.

Create Keyset
This option creates a keyset within the currently selected keyset space.
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Deallocate
This option removes the selected spare keyset space.

Keyset Management Utility

The keyset management utility (gmksm) is designed for the SafeNet ProtectToolkit-M user, and allows the following
operations:

¢ Create keysets

e Generate key pairs

¢ Delete key pairs

*  Show key pair properties
¢ Addkey containers

¢ Remove key containers
¢ Change passwords

Please note that this section is only intended as a reference for the keyset management utility. When performing
administrative tasks, the reader is advised to refer to "Administrative Tasks" on page 32 for details regarding each task.

Figure 1: Keyset Management Utility User Interface
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Starting and Exiting the Keyset Management Utility

To start the keyset management utility, select Start > Programs > SafeNet > ProtectToolkit M > gmksm. After an
initial splash screen, the main user interface is shown (see"Keyset Management Utility User Interface" on the previous

page).
To exit the utility, select Exit from the File menu.

User Interface
The keyset management utility is presented as a Graphic User Interface (GUI), divided into two main areas. These are:

¢ The Menu Bar — which is shown along the top of the utility. All available utility commands can be activated via
these menus.

* The main display pane —shows all keysets, spare keyset spaces, key containers, and key pairs. These are
represented as a hierarchical tree view, with keysets being the highest member. Key containers and key pairs are
shown beneath each keyset.

Password Entry Dialogs

Most actions performed within the keyset management utility will require entry of the keyset user password. The keyset
password is case-sensitive and may consist of any alphanumeric characters, between 4 and 32 characters in length.

Figure 1: Keyset password entry dialog

P Mprovy Keyset Password - Keyset DENNIS_Keyset
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Kepset Pagsword [4-32) |-|
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For Session k. Cancel

Keep Password Feature

The utility can remember the keyset password for the duration of the session. This eliminates the need to repeatedly
enter the password for multiple operations.

To enable this feature, check the box next to Keep Password For Session when entering the keyset password.

CAUTION: When this feature is enabled, take care not to leave the utility unattended. To
ensure that unauthorized people do not obtain access to a user keyset, close the keyset
management utility once you have finished with your task.

Keyboard Shortcuts

All available menu items may be activated via keyboard shortcuts. The menu bar can be selected by pressing the [Al{]
key. Commands may then be selected by pressing the first unique letter of the required command. For example: [Alt]
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followed by [K] will open the Keyset menu.

There are also a number of key combination shortcuts which will immediately activate a command:
* CTRL+A = Add Container

* CTRL+R = Remove Container

* CTRL+K = Create Keyset

e CTRL+P = Change Password

e CTRL+G = Generate Key Pair

* CTRL+D = Delete Key Pair

Context Menus

Right-clicking on an item in the main display pane will bring up a context menu showing available commands specific to
that item.

For details about these commands, please refer to the section appropriate to the menu in question.

Container Menu

The Container menu is used to perform the following user actions on a keyset container:

Remove
This option removes the selected key container.

& CAUTION: This action destroys any key pairs contained within the selected container.

Generate Key Pair
This option generates a key pair within the selected container. The user is prompted for:

* Key Usage: Select "Sign" or "Exchange".
* Key Size: Valid lengths are 512, 768, 1024, 2048 or 4096 bits.

* Exportable: Checking this box allows the generated private key to be backed up to a file on the host machine.

Key Pair Menu

The Key Pair menu is used to perform the following user actions to a selected key pair:

Delete
This option deletes the selected key pair

Properties
This option displays the properties of the selected key pair. The following attributes are shown:

¢ Keyset: Displays the name of the keyset where the selected key pair resides.

¢ Container: Displays the name of the key container where the selected key pair resides.
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e Usage: Displays the key usage attribute of the selected key pair. This value will be “‘EXCHANGE” or “SIGN”.
e Size: Displays the size of the selected key pair.

e Private Key Held: If "TRUE", the private key for the selected key pair is present as part of the key pair. It is only
possible to import a public key .

e Exportable: Indicates whether the selected key pair can be backed up.
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CTKMU

Key Management Utility for the SafeNet ProtectToolkit-C environment.

Synopsis

ctkmu |c Create key from entered components
-t<type> -n<name> -a<attribute> -k<num> [-s<slot>] [-z<size>] [-i<hex string>]
[-P]

Create key with components
-t<type> -n<name> -a<attribute> -k<num> -g [-s<slot>] [-z<size>] [-i<hex string>]

Create key without components

-t<type> -n<name> -a<attribute> [-s<slot>] [-z<size>] [-i<hex string>]
[-C<curve name>]

d Delete object
-n<name> [-s<slot>]

e Erase smart card
-c<slot>
i Import key(s) from single-custodian smart card

-w<name> -c<slot> [-s<slot>]

Import key(s) from multi-custodian smart cards
-c<slot> [-s<slot>]

Import key(s) from console

-a<attribute> -n<name> -t<type> -w<name> -y [-s<slot>] [-i<hex string>] [-m]
[-z<size>]

Import key(s) from file

-w<name> <filename> [-s<slot>] [-2]

idp | Import domain parameters
-n<name> -t<type> -a<attribute> <filename> [-s<slot>]

it Import token

<filename> [-s<slot>]

j Import from PKCS #12 file

-n<name> -a<attribute> <filename> [-s<slot>] [-i<hex string>]

1 List objects on token(s)

[-s<slot> [-v]] [-n<name>]

m Modify attributes

-n<name> -a<attribute> [-s<slot>]

P Initialize or change PINs
[-s<slot>] [-0]
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rt

Replicate token
-d <slotlist> [-s <slot>]

Smart card status
-c<slot>

Initialize/re-initialize token
[-s<slot>] [-1l<label>]

Export key(s) to single-custodian smart card
-w<name> -c<slot> [-s<slot>] [-3] [-n<name>]

Export key(s) to multi-custodian smart card
-c<slot> [-s<slot>] [-3] [-n<name>] [-M]

Export key(s) to file

-w<name> <filename> [-s<slot>] [-3] [-n<name>]

Export key(s) to console

-n<name> -w<name> -y [-s<slot>] [-m]

Export key(s) to PKCS #12 file

[-s<slot>] --pkLabel --keyCertLabel [--certalgo]

[--pkalgo]

xt

Export token

-S<serial> <filename> [-s<slot>]

Description

The ctkmu utility is used for SafeNet ProtectToolkit-C token management. This includes operations required by a
token’s SO, such as setting user PINs and re-initializing tokens, as well as those operations required by the normal
User, such as object management.

A number of commands can be used with the ctkmu utility to help with key creation, deletion, import, export, as well as
PIN change, token initialization and replication.

Note: When operating in WLD/HA mode, this utility should only be utilized to view the
configuration. Any changes to the configuration should be made when operating in NORMAL

mode.
Commands
Command Description
c Create Key

This command is used to generate new keys on the specified token. The —a parameter is used to
specify the attributes, the —n parameter specifies the key’s label and the —t parameter the new key
type. "PKCS #11 Attributes" on page 86 contains further information on key attributes. Common
uses for this command are generation of a random key, import of a split custodian key (using the —k
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Command Description

flag), or creation of a split custodian key (using the —g and -k flags). When importing a split custodian
key, optionally, a supported PIN pad device can be used (using the —p flag) to ensure that the key
components are entered directly to the device.

d Delete Key

This command is used to delete a key on the specified token. This command will permanently
destroy the key with the label specified with the —n parameter.

e Erase Smart Card

This command is used to erase a smart card in the specified slot and will leave the smart card in an
un-initialized state.

i Import Key
This command is used to import keys previously exported with the export command (see below).

idp Import Domain Parameters

This command is used to store Domain Parameters objects onto a Token.

The —s option indicates the slot e.g. —s1 for slot 1 —default is slot 0.

The —n option indicates the label of the new object.

The —t option specifies the key type, it may be ec or dsa or dh but only ec is supported.

The —a option allows attributes to be specified. Only the ‘P’ private and ‘M’ Modifiable attributes are
allowed. The default attribute if —a option is missing is CKA_PRIVATE=false and CKA_
MODIFIABLE=false.

The <filename> option specifies a test file that contains the information required to construct the
domain parameters.

it Import Token

This command is used to import a token image into the specified token. The -s parameter identifies
the token that will be replaced with the imported token image, by default slot 0 is used. The
<filename> parameter specifies the token image file to import.

To complete this operation, ctkmu will prompt for the user PIN of the destination token.

When importing into an un-initialized token, ctkmu will prompt for the SO PIN of the destination
token. If the device is running in FIPS mode, ctkmu will prompt for the device administrator PIN of
the destination token.

3 Import Private Key
This command is used to import a Private Key and a Certificate from a PKCS #12 file format.

1 List Information

This command is used to display information on the objects stored on the token in the specified slot.
This command will list the actual keys, certificates and other objects, or, if the token is a smart card
token previously used with the key export function information on that key backup set.

m The Modify Attributes command ‘m’ is used to toggle the specified attributes. That is, change from
TRUE to FALSE and vice versa or add the attribute if it does not exist.

P The Pin command ‘p’ is used to initialize the User PIN or to change an existing PIN (either the User
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Command Description

or SO PIN) the command will prompt. 'Cannot change the pin for the token in slot 1 as it is not
initialized. You can use the command "ctkmu t -s 1" to initialize this token.'

If the PIN is initialized the current PIN will be prompted for before the new PIN may be specified. To
change the SO PIN, specify the —O option.

rt The replicate token command 'rt' is used to replicate a source token to one or more destination
tokens. The -s parameter identifies the source token to be replicated, by default slot 0 is used. The -d
parameter specifies one or more destination tokens to replicate the source token to.

If an error occurs replicating to a particular token, an error will be reported and that token will be
skipped. This prevents offline or faulty devices from spoiling the replication process for other tokens.

To complete this operation, ctkmu will prompt for the user PIN of the source token.

When replicating to an un-initialized token, ctkmu will prompt for the SO PIN of the destination
token. If the device is running in FIPS mode, ctkmu will prompt for the device administrator PIN of
the destination token.

s The Smart Card status command ‘s’ is used to display information on the smart card token currently
inserted in the specified slot. Details of the keys exported to the token will be displayed.

t The Initialize/Reset Token command ‘t’ allows for existing tokens to be initialized or re-initialized. If
the specified token contains an initialized token the current SO PIN will be prompted for before a new
Token label may be specified and the token re-initialized. If the token is un-initialized this command
will only operate if the ‘No clear PINs’ flag is not specified for the HSM (otherwise only the
Administrator may initialize tokens with the ctconf utility). In this case the new SO PIN and label
may be specified. Once the token has been reset or initialized a new user PIN may also be set.

X The Export Key command ‘x’ allows for keys to be exported to one or more smart cards or to a file or

to the screen.

Keys exported to the screen are wrapped with standard algorithm and are suitable for transport to

foreign systems. Keys wrapped for smart card or file backup use proprietary algorithms and can only

be restored to compliant SafeNet ProtectToolkit-based HSMs.

The main difference between the standard and proprietary methods is that the proprietary method

wraps all the attributes of the key so that when a key is restored it must contain the same attributes

as the original.

Keys wrapped for smart card backup may use one of two basic methods; keys may be exported as

split custodian in which case they will be encrypted using a randomly generated key which is then

split and distributed to a number of smart card tokens. Alternatively a key wrapping key may be
specified which will then be used to encrypt the key specified for backup. This encrypted data can
then be written to a smart card token or to afile.

Please note that if the -j parameter is used to export a private key and certificate to a PKCS#12 file

format the following considerations need to be made. Exportable private key types are: RSA, DSA,

and ECDSA.

» If the private key being exported is marked CKA_EXPORTABLE=TRUE and CKA _
EXTRACTABLE=FALSE, the toolkit will prompt for Security Officer (SO) to login to perform the
export operation.

e User performing the PKCS#12 private key export will be asked to provide two (2) passwords
(one for Payload and one for HMAC). At this stage the user must take into account which 3rd
party tools will be used to extract the PKCS#12 file. For example, Microsoft Windows requires
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Command Description

that the Payload and HMAC passwords be identical. OpenSSL, however, will extract Key and
Certificate exported by ctkmu using two different passwords. The user needs to decide which
password policy best suits their needs.

The RC family of encryption algorithms (and others) are prohibited in FIPS mode. ctkmu shall
reject the command and display a warning message if they are used under this security policy.

xt The export token command 'xt' is used to export a token for later import to a specific device. The -s

<slot> parameter identifies the source token to be exported, by default slot 0 is used. The -S

parameter specifies the serial number of the intended device where token import will be later

performed. The <filename> parameter specifies the output token image file. To complete this
operation, ctkmu will prompt for the user PIN of the source token.

Options
Option Description
-a<attributes> | --attributes =<attributes>
Specifies attributes for an object / key. Valid attributes are:
P CKA_PRIVATE=1
M CKA_MODIFIABLE=1
T CKA_SENSITIVE=1
w CKA_WRAP=1
w CKA_EXPORT=1
I CKA_IMPORT=1
U CKA_UNWRAP=1
X CKA_EXTRACTABLE=1
X CKA_EXPORTABLE=1
R CKA DERIVE=1
E CKA_ENCRYPT=1
D CKA _DECRYPT=1
S CKA_SIGN=1
Vv CKA_VERIFY=1
L CKA_SIGN_LOCAL_CERT=1
C CKA_USAGE_COUNT=1 (can only be used with ¢ command)
-c<slot> --sc-slot-num =<slot>

Specifies the Smart Card slot to export to or import from.

-C<curve_ name>

--curve-name =<l|abel>

Specifies which curve to use. Valid values are:

* P-192 (also known as prime192v1 and secp192r1)
e P-224 (also known as secp224r1)

* P-256 (also known as prime256v1 and secp256r1)
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Option Description

* P-384 (also known as secp384r1)

e P-521 (also known as secp521r1)

*  ¢c2nb191v1

* c2tnb191vie

* orany valid Domain Parameters object label

If tec is specified, the —C parameter must be included in the command otherwise ctcert will
exit with an error message.

-d<slotlist> -—-dest =<slotlist>

Specifies a comma-separated list of tokens identified by slot number. The special value all
denotes all initialized tokens with a token label identical to the source token label and where
trust has been established between the devices.

<filename> Specifies afile to be created for export or used to import a key, certificate, token, or set of
domain parameters.

-g --gen-comp
Generate key components.

-h, -2 --help
Display usage information.

-3j -pkcs12

Export to PKCS#12 format.

—pkLabel

Private Key to be exported to PKCS#12 file.

—keyCertLabel

Certificate Label to be exported to PKCS#12 file.

—pkalgo

Private Key Encryption Algorithms. This parameter is optional. The default setting is DESS3.
Possible settings are: RC4_128, RC4 40, DES3, DES2, RC2_128, RC2_40.

Note that if FIPS mode is ON, then none of the algorithms in the RC family are allowed.
—certalgo

Certificate Encryption Algorithm. This parameter is optional. In FIPS mode the default setting
is DES3. If FIPS mode is OFF, the default setting is RC2_40. Possible settings are: RC4 _
128, RC4_40, DES3, DES2, RC2_128, RC2_40.

-k<numb> -num-comp =<numb>

Number of key components required to be entered or number to be generated (when —g
parameter is specified).

-1<label> -label =<label>
Specify label.
-m --multi-part

Do a multi-part key entry for console import/export.
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Option Description
-M --NofM
Causes the N of M scheme to be used for a multiple-custodians backup. This means that the
key is split in such a way that the original key may be recovered with the co-operation of any
of the custodians with a user specified, minimum number of custodians being required.
-n<name> --name =<name>
Name of the object to operate on.
-0 -SO-PIN
Change the Security Officer PIN. Used with the change PIN command.
-p --pinpad
Use a supported PIN pad device for entering key components.
-s<slot> --slot-num =<slot>
Specifies the slot to operate on. Default is 0 (zero), however must be specified when using
the | command and —v option for Slot 0.
-S<serial> --serial =<serial>
Specifies the device serial number.
-t<type> ~-type=<type>
The type of key to create. Options are: aes | des | des2 | des3 |rc2 |rc4 |cast| idea| seed | rsa |
dsa|ec.
-v --verbose
Displays the attributes that ctkmu may change.
-w<name> --wrap-key =<name>
Name of the key used to wrap or unwrap.
-y --console
Import/Export using the console.
-z<size> --size=<size>
Size of the key to create/import (for AES, RC2, RC4, CAST, RSA, DSA and generic secret).
-2 -Cprov2
Import keys from a Cprov 2 formatted file. This is used when migrating keys from an older
Cprov 2 key format to the current format.
-3 -PTKC3
Generate export to smart card and file using the SafeNet ProtectToolkit-C version 3 format.
Used when exporting keys to be sent to older style HSMs.
Exit Status

The ctkmu utility will return a zero(0) exit status when successful. A non-zero exit status is returned on an error.
Warnings are not treated as errors.
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CREATECERT Utility

Utility for creating a self-signed certificate.

Synopsis

createcert <X509 Name>

Description

The createcert utility is used as a quick and simple method of creating a self-signed certificate for the SafeNet
ProtectToolkit-M machine.

@ Note: The user must be logged on as administrator to use this utility.

Parameters

X509 Name The X.509 Certificate name. For example, CN=<machinename>.
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Integration with Microsoft CA

This section contains the following instructive subsections for integration with Microsoft CA:
* "Setting Up a CA with SafeNet ProtectToolkit-M" below

» "Certificate Template Support for SafeNet CSPs" on the next page

* "CA Replication (Key Backup and Recovery)" on the next page

* "Private Key Archiving and Recovery" on page 68

Setting Up a CA with SafeNet ProtectToolkit-M

This section explains how to configure SafeNet ProtectToolkit-M to be used with the Microsoft CA.

SafeNet ProtectToolkit-M, in conjunction with Microsoft CA, provides secure storage of keys related to signing
certificates.

Before you begin, ensure that:

e you have read and understood "Installation" on page 14 and "Setup and Configuration" on page 16.
¢ Microsoft CA has NOT been installed prior to the SafeNet ProtectToolkit-M installation.

e the current logged-on user has Windows administrator privileges.

e akeyset exists for the logged-on user.

An example of how to setup the CA with SafeNet ProtectToolkit-M on Microsoft Windows 2008 R2 follows.

Note: This example assumes a standalone configuration for a root CA. Actual values should
be chosen as required, to suit each particular installation.

To set up the CA with SafeNet ProtectToolkit-M:
From the Windows Control Panel, select Administrative Tools and select Server Manager from the list of tools.

Click Add Roles.

Check the box for “Active Directory Certificate Services”, click Next, and then Next again.
Check the box for “Certification Authority” and click Next.

Select Standalone and click Next.

Select Root CA and click Next.

Select the appropriate option (new or existing private key) and click Next.

Select the SafeNet CSP from the list, configure your cryptiographic options as required, and click Next.

© ® N o g > 0N~

Configure your CA name as required and click Next.

10. Set the validity period for the certificate generated for the CA as required and click Next.
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11. Specify the locations for the certificate database and certificate database log and click Next.

12. Review the CA configuration. If any parameters are incorrect, use the links in the left pane to return to the
appropriate page to make changes. When the configuration is correct, click Install to install the CA.

Following the successful completion of the above steps, SafeNet ProtectToolkit-M is now selected as the CSP for
Microsoft CA operations. For further details regarding the Microsoft CA, please refer to your Microsoft documentation.

Certificate Template Support for SafeNet CSPs

The current list of certificate templates in the CA do not make use of the SafeNet CSP. New templates must be created
in the Certificate Templates store and then issued from the CA templates store. For example, a web server certificate
template only supports the Microsoft DH and RSA providers.

In order to create new templates that support the SafeNet CSP, perform the following procedure. The procedure is
basically the same for any certificate that you need to issue using the SafeNet CSPs.

To create a new template that supports the SafeNet CSP:

Note that the use of the User template in this procedure is for example only. Substitute this for any other template to
meet your particular requirements.

1. Start anew MMC session and add both the Certification Authority and Certificate Template snap-ins.

2. Expand the Certificate Templates object and locate the User template.

3. Right click on the User template and select Duplicate template. This will display the new template properties.
4. Entera Template display name. Note that you cannot give it the same name as the template that already exists.
5

Go to the Request Handling tab and click on the CSP button. Either select Requests can use any CSP
available on the subject’s computer or make sure that the SafeNet RSA providers are checked.

6. Check the Issuance Requirements and Security tabs to ensure that the appropriate permissions are correct.
Click OK to complete.

7. Now go tothe CA object and select Certificate Templates.
8. Right click New and select Certificate Template to Issue.
9. Locate the new template that was created in steps 1-6 and click OK. Close the MMC console session.

10. Totest that the SafeNet provider is now available, open a new MMC console and choose the Certificates snap-in.
Select My User Account when prompted. The Administrator's personal certificate store is now available.

11. Right click on the personal object and select All Tasks, Request new certificate. The Certificate Request Wizard
displays.

12. Click Next to reveal the certificate types available, select the new certificate and check the Advanced check box.
Click Next.

13. Onthe CSP page that now displays, note that the SafeNet providers are now listed. Choose the RSA full provider
and any other appropriate settings such as Key is Exportable, etc. Complete the process by clicking OK.

The certificate is generated and visible in the personal store.

CA Replication (Key Backup and Recovery)

Typically, to replicate a CA installation, keys may be backed up to smart cards and then restored from the smart cards
to establish the new CA installation. One smart card per keyset is required.
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A triple-DES BackupKey is used to encrypt each keyset prior to storage on a smart card. A different BackupKey is
automatically created for each keyset when the keysets are created but these keys are not visible under normal
SafeNet ProtectToolkit-M operation. A BackupKey for a keyset is derived from a combination of the password used to
secure that particular keyset and the keyset name. In the case of the MACHINE and SYSTEM keysets, the device
administrator's password and the keyset name are used to derive the key. Thus, to restore a keyset that was previously
backed up, the same password and keyset name must be used.

To Back Up Keys for a CA Installation to Smart Cards:

1. Obtain a listing of all keysets by executing ctkmu | from a command prompt. A list of all keysets and associated
slots displays.

Note: Decide which keysets to back up. At a minimum, the MACHINE_Keyset must be
backed up, as this is where the CA keys are stored.

2. Record the slot number for each keyset that you wish to back up.

3. Toback up the MACHINE_Keyset to smart card, type the following in a command prompt, where nis the slot
number of the MACHINE_keyset and b is the slot number representing the smart card reader. Both nand b can be
found in the listing obtained at step 1.

ctkmu x —-sn —-wBackupKey -c

4. When prompted for a user password, enter the default “password”.
5. Insert a new smart card and repeat steps 4 and 5 for the SYSTEM_Keyset if required.

Insert a new smart card and repeat step 4 for each of the other keysets required.

Replicating a CA Using Keys Restored from Backup Smart Cards
The following procedure takes the following key points into account:

* Onthe machine where the replica is to be created, SafeNet ProtectToolkit-M must be installed before the Microsoft
CA.

* Toallow installation of a CA that utilizes the SafeNet CSP for HSM storage of keysets, both the MACHINE_
Keyset (where the CA stores keys) and a user keyset for the current user must be available. At CA installation time
if either or both of these keysets are missing, the SafeNet CSP will not display in the list of CSPs available for
selection.

* Allkeyset names and associated passwords created when establishing the replica must match the originals that
are to be restored from the backup smart cards.

To Replicate a CA Using Keys Restored from Backup Smart Cards:
1. Install SafeNet ProtectToolkit-M.

2. Start the SafeNet ProtectToolkit-M administration utility. This can be done via the Windows Start menu. Select
Start > Programs > SafeNet > Protect Toolkit M > gmadmin.

A MACHINE_Keyset and a SYSTEM_Keyset will be created. Later on, the MACHINE_Keyset created here will be
replaced with the version that was backed up to smart card, containing the CA keys.

The device administrator password will be requested, or must be set if this is the first time the HSM has been
accessed.

The Administration Utility default view displays.
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10.

11.
12.
13.

14.

Under Active Adapters, expand All to reveal the device and the Machine and System key sets just created on that
device.

Highlight the device entry and select Adapter on the menu bar. Now select Allocate Space to create a keyset
space.

Under Active Adapters, select the spare keyset space.

Select Keyset on the menu bar and then choose Create Keyset. The Administration Utility will now prompt for a
keyset name to use and the password for the currently logged-on user. The default name should be accepted.

If additional user keysets containing keys are to be restored from smart card, create an empty replica keyset on the
HSM for each keyset to be restored with the same name and user password as the original. To do this, repeat steps
4 to 6 for each keyset, using the appropriate keyset name and user password each time.

Obtain a listing by name of all the keysets that now exist on the HSM and their corresponding slot numbers by
executing ctkmu | from a command prompt.

Import a keyset from smart card to the HSM. To do this, insert the smart card containing the keyset and execute
the following command from a command prompt:

ctkmu i -sn -wBackupKey -cm
where nis the slot number of the keyset on the HSM discovered in step 8, and m is the smart card reader slot
number. This will also be shown in the listing obtained at step 8.

When prompted for a user password, enter the value for the keyset being restored. In the case of the machine and
system keysets, the default is “password”.

Insert a new smart card and repeat step 4-10 for each additional keyset until all have been restored.
Install the Microsoft CA.

Select the SafeNet CSP from the drop-down box during installation. If the SafeNet option is not present, this
means that the keyset for the currently logged in user does not exist. Ensure the user is the same as the user who
did the backing up of the CA initially.

After selection of the SafeNet CSP, click the Use existing keys box and select the key that corresponds to the CA
key pair.

Private Key Archiving and Recovery

When requesting a certificate using the Windows CA, users have the option to have their private key archived by the
CA. In a catastrophic system failure that results in the user losing their entire system, this feature allows recovery of
the user’s private key.

Support for this archival and recovery process is included in SafeNet ProtectToolkit-M. The following examples
demonstrate the use of this capability.

Private Key Archiving Example

Here are the tasks required to archive a private key using a Microsoft certification authority (CA).

Create a key recovery agent account
Acquire the key recovery agent certificate
Configure the certification authority to allow key recovery

Create a new certificate template that allows key archiving
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Acquire a user certificate that has an archived key

Prerequisites
Before doing these tasks:

You must have a Windows Server domain controller.
The Windows Server domain controller must also be configured as an enterprise root or subordinate CA.
A user keyset for the user must exist. Refer to "Creating User Keysets" on page 21 for further information.

The Allow Clear Export of Private Keys flag must be set. See the section "Enabling Private Key Clear Export" on
page 41 for the procedure.

Task 1—Creating a Key Recovery Agent Account
Configure and add the Key Recovery Agent certificate template as a template that can be issued by the enterprise CA.

To verify who can enroll the Key Recovery Agent template:

1.
2.

Log on as administrator.

Click Start, Run, type certtmpl.msc, and press Enter.

This opens the Certificate Templates snap-in in the Microsoft Management Console.

In the console tree, click “Certificate Templates.”

In the details pane, right-click Key Recovery Agent and click Properties.Select the Security tab.

By default, the security groups that can enroll the Key Recovery Agent certificate template are Domain
Administrators and Enterprise Administrators.

To allow other users or groups to enroll the Key Recovery Agent certificate template, click Add to add the user or
group and grant them Read and Enroll permissions.

To change the default issuance behavior of the Key Recovery Agent template:

1.
2.
3.

In Key Recovery Agent Properties, click the Issuance Requirements tab.
Clear the CA certificate manager approval check box and click OK.

Close the Microsoft Management Console.

To change the request handling to allow the Safenet CSPs:

1.
2.

In the Key Recovery Agent Properties, click the Request Handling tab.
Check the Allow Private Key to be Exported check box.

Click on the CSP button and click on the radio button to allow requests to use any CSP available on the subject’s
computer.

To configure the Certification Authority (CA) to issue Key Recovery Agent certificates:

1.

On the Administrative Tools menu, click Certification Authority.

This opens the Certification Authority snap-in in the Microsoft Management Console.
In the console tree, double-click the CA, and then click Certificate Templates.
Right-click Certificate Templates, then click New CertificateTemplate to Issue.

In Enable Certificate Template, click Key Recovery Agent, and then click OK.
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Task 2—Acquiring the Key Recovery Agent Certificate

In this series of steps, you will acquire a Key Recovery Agent Certificate for the purpose of recovering private keys.
Begin by creating an MMC console with the Certificates snap-in loaded.

To ensure that you are logged on as the administrator:
On the taskbar, click the Start button, and then click Run.

In Run, type mmc, and then click OK.

On the File menu, click Add/Remove Snap-in.

In Add/Remove Snap-in, click Add.

In Add Stand-alone Snap-in, click Certificates, and then click Add.
In Certificates, click My User account and then click Finish.

Click Close, and then click OK.

N o o b~ w Ddhd =

To acquire a Key Recovery Agent certificate:
In the console tree of the newly-created MMC console, double-click Certificates - Current User.

In the console tree, right-click Personal, click All Tasks, Request New Certificate.
In the Certificate Request Wizard, click Next.
In Certificate Types, select Key Recovery Agent and the Advanced checkbox, and then click Next.

o > DN =

On the CSP page that now displays, choose the SafeNet provider for HSM key storage and any other appropriate
settings such as Key is Exportable, etc. Then click Next and Next again.

6. Onthe Certificate Friendly Name and Description page, in the Friendly Name field, type Key Recovery, and then
click Next.

7. In Completing the Certificate Request Wizard, click Finish.
8. Inthe console tree, double-click Personal and then click the Certificates folder.
9. Ensure that a certificate with the friendly name of Key Recovery exists.

10. Close the console without saving changes.

Task 3—Configuring the CA to allow key recovery

In this series of steps, configure the enterprise CA to use the Recovery Agent certificate acquired in Task 2. The CA
must load the public key for the Key Recovery Agent to be used for encrypting the recovery data.

To configure the Recovery Agent to be the Administrator's Key Recovery Agent certificate:
1. Ensure that you are logged on as the administrator.

2. In Administrative Tools, open Certification Authority.

This opens the Certification Authority snap-in in the Microsoft Management Console (MMC).

In the console tree, click the CA.

Right-click the CA, and then click Properties.

Inthe CA Properties, on the Recovery Agents tab, click Archive the key and then click Add.

o o M w

In Key Recovery Agent Selection, click the certificate that is displayed, and then click OK. The key recovery
agent certificate is shown with a status of Not loaded.
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7. Click OK, and when prompted to restart the CA, click Yes.

To open the Certificates console, focused on the local computer:
On the taskbar, click the Start button, and then click Run.

1
2. InRun, type mme, and then click OK.

3. Onthe File menu, click Add/Remove Snap-in.

4. In Add/Remove Snap-in, click Add.

5. In Add Standalone Snap-in, click Certificates, and then click Add.

6. In Certificates Snap-in, click Computer account and then click Next.
7. In Select Computer, click Local Computer, and then click Finish.

8. Click Close, and then click OK.

To verify the installation of the Key Recovery Agent (KRA) certificate:
1. Inthe console tree, double-click Certificates (Local Computer), double-click KRA, and then click Certificates.

2. Inthe details pane, double-click the certificate.

3. Verify that the intended use of the certificate is Key Recovery Agent and the certificate is issued to Administrator.
This procedure ensures that the Key Recovery Agent has been successfully configured.

4. Click OK and then close the console without saving changes.

Task 4 — Creating a new certificate template that allows key archiving

In this series of steps, you define a new template that allows Key Archival and HSM key storage by using the
Certificate Templates console. This will allow hardware key storage within a HSM at the client computer and key
recovery in the domain in the event that the private key is lost or corrupted at the client computer.

To open the Certificate Templates console:
Log on as the administrator.

On the taskbar, click the Start button, and then click Run.

In Run, type mmc, and then click OK.

On the File menu, click Add/Remove Snap-in.

In Add/Remove Snap-in, click Add.

In Add Standalone Snap-in, click Certificate Templates, and then click Add.
7. Click Close, and then OK.

2 T

A duplicate of the Users certificate template is now created and named Archive User. This is a shortcut to creating a
template with permissions that allows both Domain Administrator and Domain User certificate enroliments. The
template is then modified so that certificate enrollments made using this template will enable both key archival and the
ability to use Safenet as a CSP.

To create a modified Archive User certificate template:
1. Inthe console tree, click Certificate Templates.

2. Inthe details pane, right-click the User template, and click Duplicate Template.
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3. Inthe Properties of New Template dialog box, in the General tab, in the Template display name box, type
Archive User.

4. Inthe Request Handling tab, enable the Archive subject's encryption private key option (see the screen shot
below). This option makes it possible for a Key Recovery Agent to recover the private key from the certificate store.

Properties of New Template ilil

lzzuance Reguirements | Superzeded Templatesl E:-:tensil:unsl Security
General Request Handling | Subject Mame

Purpoze;

v &rchive subject's encryption private key

v Include symmetric algorithms allowed by the subject

™ Delete revoked o expired certificates [do not archivel

Minirum ke zize: |1|:|24 vl

v Allow private key to be exported

Do the following when the subject iz enrolled and when the private key
azzociated with thiz certificate iz uzed;

% Enrall subject without requining any user input

™ Prompt the uger during enrallment

Prompt the wzer during enmollment and require uzer input when the
private key iz uged

To chooze which cryptographic service providers CEPs |
[C5F:] should be uged, click C5Ps. i et

)4 Cancel Apply

5. Click the CSPs button to enable HSM key storage using one or more SafeNet CSPs.

The dialog box allows selection of particular CSPs or all CSPs may be enabled by selecting the appropriate radio
button.

Typically, only the Safenet RSA Full Cryptographic Provider is required. The SChannel Provider is only
needed where SSL processing will be carried out.

6. Afterfinalizing selections, click OK and OK again to apply changes and close the dialog boxes.

7. Close the console without saving changes.

Task 5—Acquiring a User certificate that has an archived key

In this series of tasks, you will configure the certification authority (CA) to issue Archive User certificates. Using a
newly created account, you will act as a user to acquire an Archive User certificate from the CA and record the
certificate's serial number for later use.
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To configure CA to issue the new Archive User certificate template:

N o o b~ w Ddhd =

Ensure that you are logged on as the administrator.

From Administrative Tools, open Certification Authority.

In the console tree, double-click the CA name, and then click Certificates Templates.
Right-click Certificate Templates, click New, and then click Certificate Template to Issue.
In Enable Certificate Templates, click Archive User and then click OK.

The Archive User certificate template now appears in the details pane.

Close Certification Authority.

To create a new user account:

1

2
3.
4

In Administrative Tools, open Active Directory Users and Computers.
Double-click the domain.

Select Users then click the Create a new user in the current container button.
Complete the following fields to create a user account:

a. First name

b. Last name

c. User logon name (e.g. JSmith@xxxx.com)

d. Password

Click Next, and then click Finish.

Double-click the new user account, select the General tab and enter the email address. e.g. JSmith@xxxx.com.
This is required if the option to include the email name is set in the template used to create the user (Subject Name
tab).

For the purpose of demonstration here, add the user to the Server Operators group so they are able to log on locally
to the domain controller. This would not normally be required.

a. Select the Member of tab.

b. Click Add, in Select Groups, type Server Operators, click Check Names, and then click OK.
c. Click OK to close Properties.

Close Active Directory Users and Computers.

Close all open windows and log off the computer.

To open the Certificates console:

S L T o

Log on as the user.

On the taskbar, click the Start button, and then click Run.

In Run, type mme, and then click OK.

From the File menu, click Add/Remove Snap-in.

In Add/Remove Snap-in, click Add.

In Add Stand-alone Snap-in, click Certificates, click Add, and then click Close.
Click OK to close the Add/Remove Snap-in dialog box.
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To use the Certificates MMC to acquire an Archive User certificate:
1. Inthe newly-created MMC console, in the console tree, double-click Certificates (Current User).

2. Inthe console tree, right-click Personal, click All Tasks, and then click Request New Certificate.
3. Inthe Certificate Request Wizard, click Next.

4. Under Certificate types, select Archive User and check the Advanced checkbox. Then click Next.
5

On the CSP page that is now visible, choose the SafeNet provider for HSM key storage and any other appropriate
settings such as Key is Exportable, etc. Then click Next and Next again.

S

In Friendly name, type Archive User, and then click Next.
7. On Completing the Certificate Request Wizard, click Finish.

If the dialog box shown below displays, the most likely cause of the problem is that the Allow Clear Export of
Private Keys flag has not been set. See "Enabling Private Key Clear Export" on page 41 for details.

Certificate Request Wizard x|

@ The certificate request Failed, The key is not exportable,

8. Double-click Personal, and then click Certificates.
9. Inthe details pane, double-click the certificate with the friendly name of Archive User.
10. In Certificate, click the Details tab.
Note that the certificate template used to generate this certificate was Archive User, then click OK.
11. Close the new console without saving changes.

12. Close all windows and log off of the computer.

Private Key Recovery Example

Here are the tasks required to recover a lost private key previously archived using a Microsoft certification authority
(CA).

e Perform key recovery

* Import the recovered private key

Task 1—Performing a Key Recovery

In this series of tasks, perform a key recovery by using Certutil.exe. For more information on Certutil, see your
Microsoft documentation.

First, ensure that the private key is recoverable by viewing the Archived Key column in the Certification Authority
console and obtain the certificate serial number required for recovery.

To obtain the certificate serial number of the confirmed recoverable private key:
1. Log on as the administrator.

2. From Administrative Tools, open Certification Authority.
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10.
11.

In the console tree, double-click the CA, and then click Issued Certificates.
From the View menu, click Add/Remove Columns.

In Add/Remove Columns, in Available Column, select Archived Key, and then click Add. Archived Key
should now appear in Displayed Columns.

Click OK and then, in the details pane, scroll to the right and confirm that the last issued certificate to the user has a
Yes value in the Archived Key column.

Note: A certificate template must have been modified so that the Archive bit and Mark Private
Key as Exportable attributes were enabled. The private key is only recoverable if there is data in
the Archived Key column.

Double-click the Archive User certificate.
Click the Details tab

Write down the serial number of the certificate. (Do not include spacing between digit pairs.) This is required for
recovery.

The serial number is a 20 character, hexadecimal string. The serial number of the private key is the same as the
serial number of the certificate.

For the purposes of this walkthrough, the serial number is referred to as serialnumber.
Click OK.
Close Certification Authority.

To recover the private key into a BLOB output file using certutil.exe:

1.
2.
3.

From a command prompt, type cd \ and then press Enter.
Ensure that you are in the ¢:\ directory.
At the command prompt, type:

Certutil -getkey serialnumber outputblob

At the command prompt, type dir outputblob

Note: If the file outputblob does not exist, you probably typed the serial number incorrectly for

@ the certificate. The outputblob file is a PKCS#7 file containing the KRA certificates and the user
certificate and chain. The inner content is an encrypted PKCS#7 containing the private key
(encrypted to the KRA certificates).

To recover the original private/public key pair using Certutil.exe:

1.

From a command prompt, type:

Certutil -recoverkey outputblob <username>.pfx

When prompted, enter the following information:
a. Enter new password: password
b. Confirm new password: password

c. Type exit, and then press Enter.
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3.

Close all windows and log off as the current user.

Task 2—Importing the recovered private key
Restoration of the recovered private key to the users certificate store by importing the <username>. pfx file.

To log on as the user and start the Certificates mmc:

I T o

Log on as the user.

On the taskbar, click the Start button, and then click Run.

In Run, type mmc, and then click OK.

On the File menu, click Add/Remove Snap-in.

In Add/Remove Snap-in, click Add.

In Add Standalone Snap-in, click Certificates, click Add, and then click Close and OK.

To delete all certificates issued by the CA to simulate a re-installed computer:

N o g bk~ wDd =

Right-click Certificates - Current User, and then click Find Certificates.
In Find Certificates, in Contains, type the CA and then click Find Now.
On the Edit menu, click Select All.

On the File menu, click Delete.

In Certificates, click Yes.

In Root Certificate Store, click Yes.

Close Find Certificates.

To import the certificate at c:\ <username>.pfx and let the certificates be placed automatically:

1.

2
3
4.
5

In the console tree, right-click Personal and then click All Tasks and then click Import.
In the Certificate Import Wizard, click Next.

On Files to Import, in the File name box, type c:\ <username>.pfx, and then click Next.
In Password, type password and then click Next.

On Certificate Store, click Automatically select the certificate store based on the type of certificate and then
click Next.

On Completing the Certificate Import Wizard, click Finish.
If the Root Certificate Store dialog box appears, click Yes.
In Certificate Wizard Import, click OK.

Two certificates were imported. The Archive User certificate for the user is located in the Personal certificates
store and the CA certificate is located in the Trusted Root Certification Authorities store.

To verify the serial number of the imported certificate:

1
2
3.
4

In the console tree, double-click Personal and then click Certificates.
Double-click the certificate.
In Certificate, click the Details tab. Verify that the serial number matches the original.

Close all open windows and log off.
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Known Issues

This section describes some of the known issues that can occur due to incorrect configuration or usage of the SafeNet
ProtectToolkit-M product. Should you encounter any difficulties not discussed in this section, please see "Support
Contacts" on page 10.

Session Exists Error
This error may occur during an attempt to allocate additional keyset space or during a delete keyset operation.
Problem: Error message during keyset delete or during space allocation / de-allocation.

Cause: There are applications that have open sessions to SafeNet ProtectToolkit-M. Certain administrative operations
require exclusive use of the system as a security measure; these include keyset sensitive tasks such as space
allocation and keyset deletion.

Solution: Close or temporarily stop any applications or services that may be using SafeNet ProtectToolkit-M such as
Certificate Services, IIS etc.

To check if an application has any open sessions to SafeNet ProtectToolkit-M, check the value shown next to
Application Count in the System section of the administration utility. This will need to be “1”, and the Total Session
Count must be “0” in order for the chosen action to succeed.

If this error persists, try re-booting your machine and check for any self- or auto-starting applications which may open
sessions to SafeNet ProtectToolkit-M.

The Certification Authority service: CertSvc is one application that may be using SafeNet ProtectToolkit-M. If after
reboot, the application count is still > 1, try disabling the service, performing the Admin operation and then re-enabling
the service.

Also try the following if applicable:

e Stopthe CA

e Deactivate Directory Security (11S)

* Reboot machine

*  Runthe EBKRESET utility (PCle HSM only).

Note: If the value of Application Count is shown as “UNAVAILABLE”, your HSM firmware

@ doesn’t support live application counting. In such a case, it is advisable to upgrade the HSM
firmware to the latest version. Please refer to "Checking and Upgrading HSM Firmware" on
page 37.

Duplicate Container or Key Instances

It is possible that following a key restore operation, there may be more than one instance of the same container or key
within a particular keyset.
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Problem: Duplicate key or container instance showing in keyset management utility (see "Duplicate Container
Error" below).

Figure 1: Duplicate Container Error

Duplicate Container Ed |

Defaulkkeys Container exisks more than once.
Refer ko the produck documentation to correct the problem,

Cause: This is caused by performing a key restore whilst the same keys are already in existence on the selected
keyset. SafeNet ProtectToolkit-M does not replace existing keys during a key restore. Multiple instances of the same
key will cause the keyset management utility to show the keyset as being invalid.

Solution: Close any applications that are using SafeNet ProtectToolkit-M.
There are two methods which can be employed to address this problem:

First: It is possible to use the CTKMU utility to manually delete one of the duplicate keys or containers.

To delete a duplicate key object:
1. Ascertain the slot on which the duplicate object resides by performing the following command:
ctkmu |

2. List the contents of the slot. For example:
ctkmu | —s<slot> Answer Yes to view private <user> objects.

Note the name of the object which appears twice

4. Delete one of the duplicate objects. For example:
ctkmu d —s<slot> —n<object name>
The above command shows a list of objects. The only method of determining which to delete will be to look at the
date of creation.

Second: An alterative to the above is to delete the affected keyset using the administration utility.

Note: This can only be performed by the device administrator and destroys all containers and
key pairs on the selected keyset. Following deletion of the keyset, it must be recreated, and
key containers may then be restored from a backup.

Application Error

Problem: An application which was functioning correctly prior to SafeNet ProtectToolkit-M installation is now not
working.

Cause: This may be caused by the replacement of the default “RSA SChannel” provider. During installation, SafeNet
ProtectToolkit-M changes the default provider to be the “Safenet RSA SChannel” provider. In some cases this provider
is incompatible with certain applications.
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Solution: Restore the default previous provider. To ascertain which provider was used prior to SafeNet ProtectToolkit-
M installation, open the file “uninst.ini”, found in your SafeNet ProtectToolkit-M installation directory. The last line of the
file will detail the name of the provider prior to the installation.

You must edit your registry and change the required value. Do not perform this if you are uncertain on how to alter the
Windows registry. Obtain advice from your system administrator, or altematively uninstall the SafeNet ProtectToolkit-
M product to see if this fixes the problem.
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Integration With IIS

One of the uses for the Microsoft Cryptographic APl is for Secure Socket Layer (SSL) processing. This section
explains the steps necessary to configure and use SafeNet ProtectToolkit-M in conjunction with I1S.

Prior to performing any of the following, please ensure that SafeNet ProtectToolkit-M is correctly installed and
configured. For details, please refer to "Installation" on page 14 and "Setup and Configuration" on page 16.

This section contains the following instructive subsections for integration with I1S:
* "Creating a Certificate" below

* "Installing a Certificate for use with 11S" on page 82

Creating a Certificate

In order for SafeNet ProtectToolkit-M and the HSM to be used for SSL processing, a certificate needs to be set up that
specifies the details of the SafeNet ProtectToolkit-M machine.

There are multiple methods of creating a certificate for the machine:
e "Using IIS" below
* "Creating a Certificate Using the Microsoft CA server" on the next page

e "Using the createcert utility" on page 82. Note that self-signed certificates created by the utility are only of use for
testing purposes.

Using IIS

When using IS to install a certificate on the host machine, the following has to be performed:
¢ Creating a certificate request

¢ Sending the certificate request to be signed by a CA

¢ Installing the signed certificate into IS

To create a certificate request using IIS:
1. Start the Internet Services Manager from the Administrative Tools menu.

2. Highlight the Default Web Site entry, and right-click to open a context menu. Select Properties. The default web
site properties dialog opens. Select the Directory Security tab.

3. Click on the Server Certificate button. This will start the 1S Certificate Wizard.
4. Choose Create a new certificate from the available options and press Next to continue.
5. Choose Prepare the request now, but send it later from the available options and press Next to continue.

6. Select SafeNet as the security provider. On the Name and Security Settings page that now displays, check the
Select cryptographic service provider (CSP) for this certificate checkbox. Click Next to continue.
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7. Continue to follow the on-screen prompts until the certificate request is completed.

The IS Certificate Wizard creates the certificate request as a file. You should now forward this file onto your CA in
order to have it signed. The CA returns a new file, which is the signed certificate.

Refer to "Installing a Certificate for use with 11S" on the next page for details on how to install the signed certificate.

Creating a Certificate Using the Microsoft CA server

The Microsoft CA server provides a standard internet browser interface for the creation of certificates.

Note: Before starting the following procedure, ensure that the current logged on user has
Windows administrator privileges and has a valid keyset.

To create a certificate using MS CA server:

Start the MS CA services interface by opening your web browser and specifying the Microsoft CA server URL. For
example:

1.

http://hostname/certsrv

The opening dialog for CA services appears.

Select the Request a certificate option and press Next to continue. You are prompted to select the request type.

Choose, Advanced request and press Next to continue. You will be presented with the Advanced Certificate
Requests screen.

Select Submit a certificate request to this CA using a form, and press Next to continue. You will be presented
with a form to input the certificate details.

Enter the details for the certificate into the fields provided:

a.

c

-~ o a o

©

Certificate Name: enter the host machine's name. This can be found by executing the standard Windows
command hostname from a command prompt.

Intended Purpose: choose Server Authentication Certificate.

Key Options: choose SafeNet RSA SChannel Cryptographic Provider as the CSP
Key Usage: choose Exchange

Key Size: enter as required, eg. “1024”

select Create new key set

if you want to be able to back up the keys associated with the certificate at a later date, choose Mark keys as
exportable

choose Use local machine store

Additional Options: choose Hash Algorithm, e.g. “MD5”

Note: If the current logged-on user's keyset does not exist when the Safenet CSP is selected,

@ the Hash Algorithm list box at the bottom of the screen will be empty. Should this be the case,
abort this operation and create a keyset for the currently logged-on user before attempting this
task again.
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6. Press the Submit button when you have confirmed your inputs. If the Microsoft CA was configured to “Auto Issue”
certificates, you are presented with the Certificate Issued dialog.

Click Install this certificate to complete the certificate request and installation.

If CA Services is not configured to auto-issue certificates, the dialog will state that your certificate request is
pending. You will have to check on the status of the certificate using the CA services at a later time. When the
certificate is ready, you are presented with the Certificate Issued dialog.

Using the createcert utility

The createcert utility is provided as a simple means to create a self-signed certificate for the SafeNet ProtectToolkit-M
host machine.

@ Note: These certificates are intended for development and testing purposes only. Also ensure
that the current logged on user has Windows administrator privileges and has a valid keyset.

You will need to know the machine name for the SafeNet ProtectToolkit-M system. Run the standard Windows
command hostname from a command prompt.

To create a self-signed certificate using createcert utility:

From a command prompt, execute the utility createcert, specifying the machine name. For example, if the machine
name is “betaone”, the command would be as follows:

C:\>createcert CN=betaone

Successful execution of the above will result in an RSA key pair being created, as well as a certificate which is saved in
the file “selfsigned.cer”. This certificate is then automatically installed ready for I1S use.

File calles SelfSigned.cer has been saved.
Certificate created successfully and installed

Installing a Certificate for use with IIS

In order to make use of the certificate in 11S, it will need to be assigned to a website.

To install the certificate with IIS:
1. Start the Internet Services Manager from the Windows Start/Programs/Administrative Tools/ menu.
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2. Highlight the “Default Web Site” entry, and right-click to open a context menu. Select Properties. The default web
site properties dialog opens. Select the Directory Security Tab.

Default Web Site Properties : x|

Wwieb Site | Operators I Perfarmance I |SA&PI Filters I Home Directary I Documents
Directary Security | HTTF Headerz I Cuztam Errors I Server Extensions

—Anonymous access and authentication control

Enable anonumous access and edit the
w authentication methodz far thiz resource.

—IP addresz and domain name restrictions

Grant or deny access ko this resource wsing
IF addreszzes or internet domain names.

Edit.. |

— Secure communications

R equire secure communications and
enable client certificates when thiz
resource i accessed, |

Server Certificate... |

Wiew Certificate...

Ed... |

(] Cancel Apply | Help |
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3. Click onthe Server Certificate button. This will start the 1IS Certificate Wizard.

4. Depending on how the certificate was generated, the IIS Certificate Wizard will prompt for the following:

If there is an outstanding certificate request:
The IIS Certificate Wizard will inform the user that there is a pending certificate request.

1. When prompted, choose “Process the pending request and install the certificate”.

2. Continue to follow the on-screen prompts until the certificate is installed.

If there is no outstanding certificate request:
The IIS Certificate Wizard will prompt the user to assign a certificate using one of three possible methods.

1. Choose “Assign an existing certificate” from the available options and press Next to continue.

115 Certificate Wizard

Server Certificate
There are thriee methods for azsigning a certificate to a'web site.

Select the method wou want to use for thiz web site;

{~ Create a new certificate,

% fhznign an existing certihicate

" Import 2 certificate fram a Kep Manager backup file.

< Back I Hest » I Cancel

The example below shows that three certificates are currently installed.
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115 Certificate Wizard

Available Certificates
The certificates yau can use for vour Web server are lizted below,

Select a certificate:;

|zzued To | |zzued By | E spiration Date | |ntended Purpose | Frie
betaone betaone 9/11/2003 Server Authentication <M
betaone kS CA 9/11/2002 Server Authentication  <Mc
MSCA RSCA 9/11/2003 <Mr

< Back I [ent = Cancel

The first listing is a self-signed certificate, created using the createcert utility. Note that the “Issued To” and “Issued
By” fields are the same. If you decide to install this type of certificate, you will receive a “Security Alert” when trying
to access the web site using Microsoft Internet Explorer. When using self-signed certificates, you will not be able to
acquire a secure connection using Netscape 6.0. For more details please refer to"Known Issues" on page 77.

The second listing in the example is a certificate generated using Microsoft CA. Note that in this case the “Issued
To” and “Issued By” fields reflect that this is not a self-signed certificate.

The last listing in the example dialog is the Microsoft CA certificate used to sign certificate requests. This
certificate appears in the list because the CA was set up on the same machine as the one being configured.

2. Select the certificate you wish to install and press Next to proceed with the certificate installation.

This concludes the certificate installation for 1|S, and SSL connections can now be made to the default web site.
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PKCS #11 Attributes

Objects, as described by PKCS #11, consist of a number of attributes that define both the object and its access policy.
In general, the SafeNet ProtectToolkit-C system will define the object’s attributes. Access policy should be provided by
the user based on their particular requirements. The following attribute descriptions are intended to assist with these

decisions.
Attribute Description
CKA _LABEL This attribute specifies a textual label for an object. This label is used to assist in
differentiating the various objects stored on a token.
@ Note: Although SafeNet ProtectToolkit-C does not require this
attribute to be unique, various other tools may.
CKA_CLASS This attribute is assigned by the system when an object is created. There are a number of

classes in common use:

e CKO_PUBLIC_KEY

e CKO_PRIVATE_KEY

e CKO_SECRET KEY

e CKO_CERTIFICATE

e CKO_CERTIFICATE_REQUEST
e CKO_DATA

CKA_KEY_TYPE

This attribute specifies the key type associated with the object. There are many key types
supported by SafeNet ProtectToolkit-C. For example:

* CKK_AES, CKK_DES, CKK_DES2, CKK_DES3, CKK_RSA, CKK_DSA
* CKA_ENCRYPT
* CKA_DECRYPT

« CKA_SIGN
« CKA_VERIFY
« CKA_WRAP

* CKA_UNWRAP

The previous attributes describe the cryptographic operations the key may be used for.
Careful consideration should be given when assigning these attributes, to avoid key
misuse.

CKA_IMPORT

This attribute is similar to the standard CKA_UNWRAP attribute. It is used to determine if
a given key can be used to unwrap encrypted key material. The important difference
between these attributes and their standard counterparts is that if CKA_IMPORT is set to
True and CKA_UNWRAP attribute is set to False, then the only unwrap mechanism that
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10 PKCS #11 Attributes

Attribute Description
can be usedis CKM_WRAPKEY_DES3_CBC. With this combination, the error code
CKR_MECHANISM_INVALID will be retumed for all other mechanisms.

CKA_EXPORT This attribute is similar to the CKA_WRAP attribute, in that it specifies that the key may be

used to encrypt a second key, so that it may be extracted from the HSM in an encrypted
form. Unlike the CKA_WRAP attribute, however, only the Security Officer may specify
this attribute.

CKA_SENSITIVE

This attribute specifies that the key object cannot be extracted from the token in the clear.
Generally this attribute should be specified to ensure the key material is not exposed.
When the No Clear PINs flag is set only sensitive keys may be created on the HSM.

CKA_EXTRACTABLE/
CKA_EXPORTABLE

These attributes are used to specify that the key may be extracted from the token in an
encrypted (for example, wrapped) form. These attributes determine how the key may be
backed up. Please consult the key backup section in "Unauthenticated Users" in the
SafeNet Protect Toolkit-C Administration Guide for more information.
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Work Load Distribution

This chapter describes how to use Work Load Distribution (WLD) in SafeNet ProtectToolkit-M:
* "The SafeNet ProtectToolkit-C Model" on the next page

* "WLD System Setup" on page 92

e "Operationin WLD Mode" on page 97

e "Trust Management" on page 97

More information about WLD can be found in the SafeNet ProtectToolkit-C Administration Guide.

Benefits of WLD

WLD allows work to be balanced across a system by transferring units of work among HSM processing modules during
execution. The demand placed on any particular processing module is thereby reduced. This results in an increase in
the overall throughput of processing tasks for the system as a whole.

Utilization of multiple HSMs under WLD also provides redundancy in that if a HSM goes down, with the exception of
the master HSM, the work will be shared amongst the remaining operational HSMs automatically. If the master HSM
goes down this will most likely cause system failure.

WLD Limitations

Read-Only

Using SafeNet ProtectToolkit-M as a CSP under WLD is severely limited. WLD does not support write/create
operations. Therefore, the CSP cannot be used to create certificates when in WLD mode, as this involves creating a
key pair. The CSP can, however, be used to sign certificate requests that have been generated by a client, provided the
client also generated their own key pair.

Admin Token Cannot Be Distributed - Single Point of Failure

The HSM's admin token contains relevant configuration information. WLD does not allow replication of admin tokens.
SafeNet ProtectToolkit-M has a 'secure configuration', a collection of configuration items stored on a data object on the
admin token, readable but not modifiable by anyone other than the administrator. The relevant secure configuration item
here is 'clear export'. This specifies whether or not keys may be exported in the clear. Since admin tokens cannot be
replicated, it is necessary to expose the admin token of one of the HSMs in the array, called the master HSM. If the
master HSM fails, the admin token will no longer be available, most likely causing system failure.
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11 Work Load Distribution

The SafeNet ProtectToolkit-C Model

The model for SafeNet ProtectToolkit-C is based on standard PKCS #11 processing. SafeNet ProtectToolkit-C running
in hardware mode is depicted below to show how an application sends requests to a token via the PKCS #11 interface.

Figure 1: SafeNet ProtectToolkit-C Model

Application

ProtectToolkit-C
‘ Cryptoki | Device Synchronization |
et Slot Slot Slot

Data Object

Key Object

Certification
Object

Token Token Token

SafeNet ProtectServer HSM

Slots and Tokens

Inthe PKCS #11 model, a slof represents a device interface and a token represents the actual cryptographic device.
For example, a smart card reader would represent a slot and the smart card would represent the token.

SafeNet ProtectToolkit-C supports three different slot types: user slots, smart card slots and admin slots. These are
described below.

User Slots

User slots are created by the Administrator for use with applications. Each slot automatically holds a User token. All
cryptographic mechanisms are supported with these tokens. The system is configurable such that any number of User
slots may be created. It is also possible to specify the security policy setting for these slots.

In the default configuration, a single User slot is available. The Administrator can add more slots as required for the
local configuration. HSM performance degrades as the number of slots increases. Creating too many slots may cause
unacceptable performance. To ensure reasonable performance, it is recommended that you create no more than 200
slots.

Smart Card Slots

Smart card slots are automatically created and configured for each smart card reader attached to the HSM's external
serial ports. The smart card tokens can be used for storage of data objects. Their primary purpose is key backup and
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restoration. To protect objects stored on the token from unauthenticated access, these objects may be PIN-protected.
The smart card slots do not support cryptographic operations.

When a supported smart card token is inserted into a configured smart card slot, it will become available to the SafeNet
ProtectToolkit-C system. New smart card tokens are blank and require initialization before use. The storage format and
layout of files on the tokens is proprietary and can store a maximum of 5 objects (up to the storage capacity of the
actual token). Objects may be deleted; however, the storage allocated to the object is not reclaimed until the token is re-
initialized by the Security Officer or Administrator.

The Admin Slot

The Admin slot is designated for the administrator and is used for configuration and administration of the HSM. There is
only one Admin slot for each HSM.

The Admin slot holds the Admin token and it is on this token that the administration objects reside (See the discussion
on "Administration Objects" below).

PKCS #11 Objects

As shown in "SafeNet ProtectToolkit-C Model" on the previous page, each token may contain a number of objects. The
PKCS #11 standard allows for these different types of objects:

» Data objects, which are defined by an application
* Certificate objects, which represent digital certificates such as X.509
* Key objects, which can be public, private or secret cryptographic keys

Each object in the system is comprised of a number of attributes. These attributes describe the actual object as well as
the access policy for that object. For example, each object may be classified as public or private; this classification
determines who may access the object. A public object is visible to any user (or application), whereas a private object
is only visible once the user is authenticated to the token where that object is stored.

For a complete description of the object attributes, see "PKCS #11 Attributes" on page 86.

@ Note: It is recommended that the number of objects stored in any single token be less than
1000, and that the number of objects stored on the entire HSM be less than 2000.

Administration Objects

In addition to the object classes defined within PKCS #11, SafeNet ProtectToolkit-C introduces a new set of objects
known as administration objects.

The administration objects represent the hardware and contain HSM configuration settings. They can be queried by the
application and some can be modified by an administrator. The default administration objects are automatically created
when SafeNet ProtectToolkit-C initializes.

The administration objects reside on a special token referred to as the Admin token. This token has a fixed security
policy. The Admin token resides only in the Admin slot on the HSM.

User Roles

As part of the SafeNet ProtectToolkit-C configuration process, different user roles are assigned to those responsible for
the application’s administration and use.
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For SafeNet ProtectToolkit-C there are four defined roles available. These are:
e Security Officer (SO)

e Token Owneror User

¢ Administration Security Officer (ASO)

e Administrator

Standard PKCS #11 defines the first two of these, the Security Officer (SO) and the Token Owner or User. Each slot
and its associated token will have an SO and a User, each with their own respective PINs.

e A Security Officer grants and revokes access to a token and assists with key backups
¢ A Token Owner uses the token for the application

Two additional roles are defined that are only available on the Admin token. The holders of these roles handle HSM-
level administration and management. These are the Administration Security Officer (ASO) and the Administrator.
These roles effectively mirror their standard PKCS #11 counterparts.

Note: The services available to the various roles depend on the security policy set for the
HSM.

PINs and Passwords

PINs and passwords are used to authenticate users and to provide access to secured computer systems. In Cryptoki
and SafeNet ProtectToolkit-C, they are defined as variable-length strings of characters selected from the ANSI C
character set. They are case sensitive, and must be between 1 and 32 characters in length.

@ Note: The term password is not defined as something distinct from a PIN in Cryptoki
environments. You will find the terms used interchangeably in Cryptoki-related documentation.

PIN Retry Delay

A brute-force search of PINs can be stopped using two approaches:
1. Prevent logging in after a certain number of PIN failures.
2. Enforce atime-delay between login attempts after a certain number of PIN failures.

The time-delay approach is used for SafeNet ProtectToolkit-C implementations utilizing the SafeNet ProtectServer
Network HSM.

After the third failed PIN presentation, the device imposes a delay (lengthening in increments of 5 seconds) before the
next presented PIN is checked:

e third failed attempt = delay of 5 seconds

e fourth failed attempt = delay of 10 seconds
o fifth failed attempt = delay of 15 seconds

e etc.

If a PIN presentation occurs before the delay period has expired, the attempt fails with an error indicating that the PIN is
locked.
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WLD System Setup

This section provides instructions on how to set up a system for Work Load Distribution. The example system contains
3 remote HSMs and 3 virtual WLD slots with SafeNet ProtectToolkit-C running on a Windows platform.

A diagram of the resulting configuration is shown in "Example of WLD configuration" on the next page. To any
application or utility operating in WLD mode, the system of physical HSMs appears as a single virtual HSM that is
accessible via virtual WLD slots. Any application or utility that accesses the system does so through the Cryptoki
library. When an application or utility is configured to operate in WLD mode, the WLD virtual slots are the only slots

made accessible by the Cryptoki Library. An application or utility configured to operate in WLD mode cannot access the
HSM slots directly.

The arrows represent associations between the virtual WLD slots and the physical HSM slots in this configuration. For
example, WLD Slot 11 is associated with User Slot 0 on HSM 0, User Slot 5on HSM 1 and User Slot 9 on HSM 2.
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Figure 1: Example of WLD configuration
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WLD Slot Associated HSM User Slots Token Label
WLD Slot 22 Slot 1 (HSM 0) WLD_Slot 22
Slot 4 (HSM 1)

Slot 10 (HSM 2)
WLD Slot 33 Slot 2 (HSM 0) WLD_Slot 33

As illustrated in "Example of WLD configuration" on the previous page, each WLD slot shares the same token label (TL)
as the HSM slots that are associated with it. For example, WLD Slot 22 shares the token label WLD_Slot_22 with its
associated HSM User slots (1, 4, and 10).

You must know the Admin Token serial numbers (SN) when configuring the system for WLD operation. Each WLD slot
must be configured with a unique serial number allocated by the user.

During configuration, the utilities must be able to access the HSM slots directly. They are initially configured to operate
in NORMAL mode, as shown by the boxes at the bottom of the figure. After configuration, applications and utilities that
need to access the system in WLD mode must be configured to operate in WLD mode.

Configuration

1. Establish Network Communication.

Set the environment variable ET_HSM_NETCLIENT_SERVERLIST with alist of the IP addresses of the HSMs in
the order HSMO, HSM1, HSM2. IPv6 addresses must be enclosed in square brackets.

2. Set the Library Mode to NORMAL.

The HSM slots must be accessible to set up the system, so the utilities which access them must operate in
NORMAL mode. See "Operation in WLD Mode" on page 97 for more on setting the Cryptoki Library to
NORMAL mode.

3. Initialize Admin Tokens and Security Policy.
If an HSM has not been initialized, the Admin Token and Security Policy for each HSM must be configured.
4. Create User Slots.

Create User slots for each HSM, as described below.

User Slots HSM

Slot 0 0
Slot 1
Slot 2

Slot 4 1
Slot 5
Slot 6

Slot 8 2
Slot 9
Slot 10

5. Create Master Tokens.
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In this example, the master tokens are created on HSM 0 and replicated to HSM 1 and HSM 2. The master tokens
could be created on any HSM User slot that is associated with the WLD slot and then replicated to the other HSMs.
As HSM 0 has slots associated with all the WLD slots used in this example, it was selected as the HSM to hold the
master tokens.

Configure the tokens for each of the slots, according to the following table. Refer to "Configuring WLD Slots" on the
next page for further details.

HSM 0 User Slot Token Label

Slot 0 WLD_Slot_11
Slot 1 WLD_Slot_22
Slot 2 WLD_Slot_33

6. Create Keys, Certificates, Data, HW Objects on Master Tokens.
It is necessary to create any objects that are contained within the master tokens before the token is replicated.
7. Establish Trust.

For token replication to be performed from the HSM holding the master tokens to another HSM, the HSMs must
have a mutual trust relationship. Refer to "Trust Management" on page 97 for further details.

As the master tokens are located on HSM 0 and are to be duplicated to HSM 1 and HSM 2, establish mutual trust
relationships between

- HSMOand HSM1
- HSMOandHSM?2
8. Replicate Tokens.

Once trust is established the tokens can be replicated. Replicate the master tokens from HSM 0 to HSM 1 and
HSM 2 as follows:

Master Token Replication

WLD_Slot_11 Replicate token from User slot 0 (HSM 0) to User slot 5 (HSM 1)

Replicate token from User slot 0 (HSM 0) to User slot 9 (HSM 2)

WLD_Slot_22 Replicate token from User slot 1 (HSM 0) to User slot 4 (HSM 1)

Replicate token from User slot 1 (HSM 0) to User slot 10 (HSM 2)

9. Configure WLD Slots.

WLD slots are configured via environment variables at either the temporary, user or system level. Refer to
"Configuring WLD Slots" on the next page for further details. In this example, WLD slots are configured at the
system level:

a. Locate the registry key:
HKEY_LOCAL_MACHINE\SOFTWARE\SafeNet\PTKC\WLD

b. Make the following assignments:
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Variable

Assignment

ET_PTKC_WLD_SLOT 11

WLD_Slot_11,1011,WLD Slot: 11

ET_PTKC_WLD_SLOT 22

WLD_Slot_22,1022,WLD Slot: 22

ET_PTKC_WLD_SLOT 33

WLD_Slot_33,1033,WLD Slot :33

10. Set the Library Mode to WLD.

WLD mode is configured via an environment variable at either the temporary, user or system level. To any
application or utility operating in WLD mode, the HSM system appears as a single virtual HSM with a collection of
WLD virtual slots. The HSM physical slots are not accessible to applications or utilities operating in WLD mode

(see "Operation in WLD Mode" on the next page).
11. Check the WLD Slot Configuration.

Run the ctkmu (WLD mode) utility to view the slots available on the system. Only the WLD virtual slots should be
visible. Any HSM physical slot on the system which has not been associated to a WLD virtual slot will no longer be

accessible.
Example:

ProtectToolkit C Key Management Utility 5.3.0
Copyright (c) Safenet, Inc. 2009-2016

Cryptoki Version = 2.20

Manufacturer = Safenet, Inc.

WLD Slot 11 (Slot 11)

WLD Slot 22 (Slot 22)

WLD Slot 33 (slot 33)
Configuring WLD Slots

To operate SafeNet ProtectToolkit-C in WLD Mode, virtual WLD slots must be configured.

Configuration parameters for the WLD slots are specified by environment variables in the format ET_PTKC_WLD _
SLOT_n. An environment variable must be configured for each WLD slot.

Inthe ET_PTKC_WLD_SLOT_n environment variable, n defines the Slot Number, an integer in the range 0 to 99. Slot

Numbers allocated within an application must be unique.

The format of these variables is:

<WLDTokenLabel>[,[<WLDTokenSerial#>][,<WLDSlotDescription>]]

Where:

<WLDTokenLabel> is mandatory. The PKCS #11 Token Label for this WLD Token identifies the HSM Tokens

Slot Configurations.

to be used for WLD. The <WLDTokenLabel> should be unique in the complete list of WLD

<WLDTokenSerial#> is optional. You can assign any PKCS #11 Token Serial Number you wish to this WLD

Token. The default value is the same as the value of n in the configuration variable name.

<WLDSlotDescription> | is optional. You can assign any PKCS #11 Slot Description you wish for this WLD Slot.

variable name.

The default value is “WLD Slot:n”, where n is the same as the value of n in the configuration
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11 Work Load Distribution

The example below shows a conceptual configuration for three virtual slots. The entire list of WLD Slots will be visible
by any application that is using this WLD configuration.

Under Win32 and Win64, the variable name and value are stored in the HKLM (for system configuration) and/or HKCU
(for user configuration) registry, in the key SOFTWARE\SafeNet\PTKC\WLD.

Example:
To configure WLD slots at the system level:
1. Locate the registry key:
HKEY_LOCAL_MACHINE\SOFTWARE\SafeNet\PTKC\WLD
2. Assignthe ET_PTKC_WLD_SLOT_nvariables the values shown in the UNIX example above.

Operation in WLD Mode

You must configure the Cryptoki Library to operate SafeNet ProtectToolkit-C in WLD mode.

The environment variable ET_PTKC_GENERAL_LIBRARY_MODE specifies the Cryptoki Library operating mode.
This variable controls which PKCS #11 model is applied to slot and token usage.

Valid values for this variable are NORMAL or WLD or HA. If this variable is not defined, or contains an invalid value,
then SafeNet ProtectToolkit-C will operate in NORMAL PKCS #11 mode.

The HSM system appears to any application or utility operating in WLD mode as a collection of WLD virtual slots. The
HSM physical slots are not accessible to applications or utilities operating in WLD mode.

While configuring the system, it is useful to configure WLD mode with a temporary configuration parameter first by
entering set ET_PTKC_GENERAL_LIBRARY_MODE=WLD into a command prompt. Then, when configuration is
stable, set the environment variable at the user or system configuration level.

It is possible to have some applications running in WLD mode and others running in NORMAL mode on the same
platform. In this case, WLD mode will need to be set in both temporary environment variables and at either the user or
system level appropriately. For example, if three applications are to operate in WLD mode and one application is to
operate in NORMAL mode, then WLD mode should be set at the user or system level and NORMAL mode should be
set in an environment variable operating in the context of the application using it.

If any changes need to be made to the system after configuration, the Library mode must be set to NORMAL so that the
utilities can access the HSM slots directly.

To configure a basic WLD system across two SafeNet ProtectServer Network HSMs with IP addresses 192.168.1.100
and 192.168.1.101, where the participating tokens are labeled "TokName", set these configuration items:

ET HSM NETWORK_ SERVERLIST=192.168.1.100 192.168.1.101
ET_PTKC_WLD_SLOT_ 0=TokName
ET PTKC GENERAL LIBRARY MODE=WLD

Trust Management

When secure data or keys must be transferred from one HSM to another through the process of token replication, trust
management is required. Environments using Work Load Distribution (WLD) and High Availability (HA) are one
example.

Currently, trust management is supported by SafeNet ProtectServer PCle HSMs and SafeNet ProtectServer Network
HSMs.
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11 Work Load Distribution

When a WLD system is configured, tokens must be replicated across all the HSM User slots associated with a
common WLD virtual slot. It is essential that the token is deemed trustworthy before it is imported by the HSM; the
token must come from a trustworthy source, and remain unaltered during transmission.

Public-key cryptography establishes trust between HSMs. Private keys are used for signing extracted information and
unwrapping tokens. Public keys are used for wrapping tokens and verifying signed information. An RSA key-pair must
be generated on the administrative token of each device. This key-pair is referred to as the local HSM Identity Key-Pair.
The public half of the key-pair is termed the HSM Identity Public-Key, while the private portion is called the HSM
Identity Private-Key. An HSM trusts another HSM when it holds the other's HSM Identity Public-Key in its
administrative token. This is referred to as the peer HSM Identity Public-Key. "Simple trust relationships" below shows
an example of a system where simple trust relationships have been established between HSMs.

The arrows indicate the trust relationship. In this system, HSM A trusts HSM B. That is, HSM A holds the HSM Identity
Public-Key of HSM B in its administrative token. However, HSM B does not trust HSM A. HSM B and HSM C share a
relationship of mutual trust. In this system, token replication could only be performed between HSM B and HSM C (with
either device originating the tokens), as token replication requires a relationship of mutual trust.

Figure 1: Simple trust relationships

A C

"Relationships of mutual trust" below shows a system where every HSM shares a relationship of mutual trust with
every other HSM. In this scenario, token replication can be performed from any HSM to any other HSM on the system.

—> B -—>

PK-B PK-C PK-B

Figure 2: Relationships of mutual trust

PK-A
PK-C

B |«— C

PE-A
PK-B

Typically, when token replication is performed in a WLD configuration, an HSM is selected to hold the master tokens
and tokens are then replicated to the other HSMs.

"Trust relationships in a typical WLD/HA configuration” on the next page illustrates a system in a typical WLD

configuration. In this system, HSM A has been selected to hold the master tokens.
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11 Work Load Distribution

The arrows indicate the relationships of mutual trust between HSM A and the other HSMs that are necessary for token
replication to be performed. The figure also illustrates that it is not necessary to establish trust among the HSMs that
the tokens are replicated to, in other words, no trust need be established among HSM B, HSM C, HSM D and HSM E.

Figure 3: Trust relationships in a typical WLD/HA configuration

PK-B
A PK-C

AR

B C D E

PK-A PK-A PK-A PK-A

Complex trust topologies can be configured depending upon system and administrative requirements. "Complex trust
topology" below illustrates an example of a complex trust topology.

Figure 4: Complex trust topology

PK-B
PK-C
PK-A PK-A
pr-C | e——T PK-B
PK-D PK-F
PK-E PK-G
PK-B PK-B PK-C PK-C
PK-E PK-D PK-G PK-F
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11 Work Load Distribution

The ctident utility provides the mechanism for establishing, maintaining and removing trust relationships on HSMs. In
an offline environment, the ctkmu utility can be used to import and export the HSM Identity Public-Keys.

The ctident utility can be used to display, check, and remove trust relationships. It can also be used to rollover the
HSM identity keys used in trust management.
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Registry Configuration

The registry entries documented here are those created by default when SafeNet ProtectToolkit-M is installed unless
otherwise noted.

This section contains the following entries:

¢ "ptkcRuntime" below

e "CryptokiPath" on the next page

* "debuglLevel" on the next page

» "Safenet RSA Full Cryptographic Provider" on page 103

* "Safenet RSA SChannel Cryptographic Provider" on page 103

* "Default RSA SChannel Cryptographic Provider Type" on page 103
* "Default RSA Full Cryptographic Provider Type" on page 103

* "Silent User Keyset Login Password" on page 104

Disclaimer

The SafeNet ProtectToolkit-M registry configuration, as documented in this appendix, should only be modified by
personnel who are competent at making changes to the Windows registry using the regedit utility. Changing the
registry incorrectly can leave a system in an unrecoverable state and Gemalto cannot be held responsible should this
occur. If you are unfamiliar with editing the registry, it is strongly advised that you refer to your Windows documentation
or seek help from a qualified systems administrator before attempting any changes.

ptkcRuntime

Key Location
HKEY_LOCAL_MACHINE\SOFTWARE\SAFENET\ProtectToolkit M\ptkcRuntime

Type
REG_SZ

Values

The SafeNet ProtectToolkit-M product relies on the SafeNet ProtectToolkit-C product. This is a string value which is
used to record the version of the SafeNet ProtectToolkit-C runtime installed in the SafeNet ProtectToolkit-M installation
directory.
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CryptokiPath

Key Location
HKEY_LOCAL_MACHINE\SOFTWARE\SAFENET\ProtectToolkit M\CryptokiPath

Type
REG_SZ

Value

This string value is the path to where SafeNet ProtectToolkit-M is installed. This path is used to locate the required
cryptoki.dil file.

debugLevel

Key Location
HKEY_LOCAL_MACHINE\SOFTWARE\SAFENET\ProtectToolkit M\debugLevel

Type
REG_DWORD

Values

Valid values are 0 through 5. If tumed on, debug output is saved in the ptkm.log file in the root directory of the current
drive. Each level includes the output of all preceding levels.

¢ 0: no debug output
¢ 1:log the invocation of CSP related methods and if an error occurs, their return code

e 2:Internal errors are converted to NTE_SYS_FAIL. This debug level logs the internal error at the point of
conversion.

e 3: CSP function input and output parameters - but NOT user related data (such as encrypted or clear text, or data to
hash).

e 4: Otherinformation not covered by the preceding levels - but NOT user related data.
e 5 Lists the Cryptoki function calls, by name only.

Note that the debug level is read when a process loads the SafeNet ProtectToolkit-M library file. This means that in
order to change the debug level, you must first stop any SafeNet ProtectToolkit-M applications.

The log file ptkm.log is cleared during initialization of the SafeNet ProtectToolkit-M library.
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Safenet RSA Full Cryptographic Provider

Key Location

HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Cryptography\Defaults\ProvidenSafenet RSA Full Cryptographic
Provider

Description

This is the registry key (and contained values) which defines one of the CSPs installed by the SafeNet ProtectToolkit-
M product.

Safenet RSA SChannel Cryptographic Provider

Key Location

HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Cryptography\Defaults\Provider\Safenet RSA SChannel
Cryptographic Provider

Description

This is the registry key (and contained values) which defines one of the CSPs installed by the SafeNet ProtectToolkit-
M product.

Default RSA SChannel Cryptographic Provider Type

Key
HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Cryptography\Defaults\Provider Types\Type 012

Description

This is the registry key which defines the default “RSA SChannel” provider. This provider is used by applications which
request RSA SChannel services, but do not specify which provider (such as 11S).

Value

Name of the default provider, after installing SafeNet ProtectToolkit-M. This should be “Safenet RSA SChannel
Cryptographic Provider”.

Default RSA Full Cryptographic Provider Type

Key Location
HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Cryptography\Defaults\Provider Types\Type 001
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Description

This is the registry key which defines the default “RSA Full” provider. During the logon process, this provider is used to
validate the entered password.

Note: The logon process requires a particular key pair to exist. This key pair does not exist in
the “SafeNet RSA Full” provider. Therefore, the default should NOT be set to “SafeNet RSA
Full Cryptographic Provider’

Value
Name of the default provider. This should NOT be “SafeNet RSA Full Cryptographic Provider’

Silent User Keyset Login Password

Key Location
HKEY_CURRENT_USER\Software\SafeNet\ProtectToolkit M

Description

This entry is NOT created by default. Create it manually if silent User keyset login is required. See "Silent User Keyset
Login" on page 22 for further information.

Value

Enter the password as clear text for key entry “UserKeysetPassword”.
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Event Log Error Types

The following table lists the error entries that may be generated by the ProtectServer HSM firmware and written to the

HSM'’s event log.

Event records are written sequentially and chronologically. If the date and time of a later entry in the log is stating an
earlier time than an entry preceding it, it indicates that the real time clock or audit information has been altered.

Name

Description

POST ERR SRAM WRITE

POST Error: Cannot write to SRAM

POST ERR_SRAM READ

POST Error: Cannot read from SRAM

POST ERR SDRAM DATA STUCK

POST Error: SDRAM, bit stuck

POST ERR SDRAM DATA SHORT

POST Error: SDRAM data bits short
Param 1. Bit number
Param 2. Value

POST ERR SDRAM ADDR STUCK

POST Error: SDRAM address bit stuck

POST ERR SDRAM ADDR_SHORT

POST Error: SDRAM address bits short
Param 1. Bit number

POST ERR SDRAM BAD BYTESEL

POST Error: SDRAM bad bytes select

POST ERR BAD SECTORO

POST Error: POST Sector checksum is not correct

POST ERR NOMEM

Cannot allocate memory

POST ERR OS_HASH

The OS hash value is incorrect

POST ERR KAT

Known answer test failed
Param 1. Algorithm Identifier
Param 2. Error Code

POST ERR RNG

RNG did not pass chi-squared test

POST ERR NO_THREAD

Unable to start POST Thread

POST ERR SMFS

Secure memory file system error
Param 1. Error Number

POST ERR RTC

Unable to access RTC

POST ERR SER

Unable to access UART
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APPENDIX A

Event Log Error Types

Name

Description

EXCEPT UNDEF

An undefined instruction has been executed
Param 1. Address
Param 2. Instruction

EXCEPT SWI

A software interrupt generated
Param 1. Address
Param 2. Instruction

EXCEPT PREFETCH

A Prefetch abort generated
Param 1. Address

EXCEPT DATA

A Data abort generated
Param 1. Address

EXCEPT IRQ

An unhandled IRQ received
Param 1. Identifier

ERR_HOT TAMPER

Hot tamper detected

LOG_FIRST ENTRY

Initial event entry

LOG INITIALIZING SRAM

Initializing the SRAM after a tamper

LOG_EVENT LOG PURGED

Event log has been purged

ERROR ASSERT

Runtime Assertion
Param 1. File
Param 2. Line

ERROR_INIT RESOURCE

Out of resources in initialization
Param 1. File
Param 2. Line

ERROR INIT PLATFORM

Failed to detect hardware platform
Param 1. File
Param 2. Line

HEAP INVALID ADDRESS

Heap Invalid block address
Param 1. Heap number
Param 2. Address

HEAP MEM FREED TWICE

Heap: Memory Freed twice
Param 1. Address

PCCISES TIMEOUT

PCCISES: Timeout error on device
Param 1. Error

PCCISES BAD STAT

PCCISES: Bad device status
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Name

Description

Param 1. Status

PCCISES BAD DATA

PCCISES: Bad input data

PCCISES RNG STUCK

PCCISES: Continuous RNG test error
Param 1. Value

PCCISES LNAU EXCEPTION

PCCISES: Large Number Arith Hardware exception (Unit,0)

PCCISES FAILED RESET

PCCISES: Failed to reset

PCCISES RESOURCES

PCCISES: Insufficient resources to start driver

CPROV_0OS UPGRADED

OS Upgrade performed
Param 1. Mod
Param 2. Version

CPROV_OS UPGRADE FAILED

OS Upgrade failed

PROT NO SMPR

PROTECTION: HSM SMPR not found

PROT CIPHER ERROR

PROTECTION: Cipher operation failed

KEYGEN ERR PAIRWISE

Key generation: Pair-wise consistency failure

FM OP DOWNLOAD

FM Download Performed
Param 1. Mod
Param 2. Version

FM OP DISABLE

FM Disabled
Param 1. Mod
Param 2. Version

FM MODULE FAILED

FM failed to load
Param 1. Mod
Param 2. Version

PTKC CFG_CHNG

SafeNet ProtectToolkit-C config change
Param 1. New Val
Param 2. Old Val
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Glossary of terms

A

Adapter

The printed circuit board responsible for cryptographic processingina HSM

AES
Advanced Encryption Standard

API

Application Programming Interface

ASO

Administration Security Officer

Asymmetric Cipher

An encryption algorithm that uses different keys for encryption and decryption. These ciphers are usually also
known as public-key ciphers as one of the keys is generally public and the other is private. RSA and ElIGamal are
two asymmetric algorithms

B

Block Cipher
A cipher that processes input in a fixed block size greater than 8 bits. A common block size is 64 bits

Bus
One of the sets of conductors (wires, PCB tracks or connections)inan IC

C

CA
Certification Authority
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CAST

Encryption algorithm developed by Carlisle Adams and Stafford Tavares

Certificate

A binding of an identity (individual, group, etc.) to a public key which is generally signed by another identity. A cer-
tificate chain is a list of certificates that indicates a chain of trust, i.e. the second certificate has signed the first, the
third has signed the second and so on

CMOS

Complementary Metal-Oxide Semiconductor. A common data storage component

Cprov
ProtectToolkit C - SafeNet’'s PKCS #11 Cryptoki Provider

Cryptoki
Cryptographic Token Interface Standard. (aka PKCS#11)

CSA
Cryptographic Services Adapter

CSPs

Microsoft Cryptographic Service Providers

D

Decryption
The process of recovering the plaintext from the ciphertext

DES
Cryptographic algorithm named as the Data Encryption Standard

Digital Signature

A mechanism that allows a recipient or third party to verify the originator of a document and to ensure that the doc-
ument has not be altered in transit

DLL

Dynamically Linked Library. A library which is linked to application programs when they are loaded or run rather than
as the final phase of compilation

DSA
Digital Signature Algorithm
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E

Encryption

The process of converting the plaintext data into the ciphertext so that the content of the data is no longer obvious.
Some algorithms perform this function in such a way that there is no known mechanism, other than decryption with
the appropriate key, to recover the plaintext. With other algorithms there are known flaws which reduce the difficulty
in recovering the plaintext

F

FIPS

Federal Information Protection Standards

FM

Functionality Module. A segment of custom program code operating inside the CSA800 HSM to provide additional
or changed functionality of the hardware

FMSW
Functionality Module Dispatch Switcher

H

HA
High Availability

HIFACE

Host Interface. It is used to communicate with the host system

HSM

Hardware Security Module

IDEA

International Data Encryption Algorithm

IS

Microsoft Internet Information Services
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IP
Internet Protocol

J

JCA
Java Cryptography Architecture

JCE
Java Cryptography Extension

K

Keyset

A keyset is the definition given to an allocated memory space on the HSM. It contains the key information for a spe-
cific user

KWRAP
Key Wrapping Key

M

MAC

Message authentication code. A mechanism that allows a recipient of a message to determine if a message has
been tampered with. Broadly there are two types of MAC algorithms, one is based on symmetric encryption
algorithms and the second is based on Message Digest algorithms. This second class of MAC algorithms are
known as HMAC algorithms. A DES based MAC is defined in FIPS PUB 113, see http://www.itl.n-
ist.gov/div897/pubs/fip113.htm. For information on HMAC algorithms see RFC-2104 at http://www.i-
etf.org/rfc/rfc2104.txt

Message Digest

A condensed representation of a data stream. A message digest will convert an arbitrary data stream into a fixed
size output. This output will always be the same for the same input stream however the input cannot be recon-
structed from the digest

MSCAPI
Microsoft Cryptographic API

MSDN

Microsoft Developer Network
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P

Padding

A mechanism for extending the input data so that it is of the required size for a block cipher. The PKCS documents
contain details on the most common padding mechanisms of PKCS#1 and PKCS#5

PCI

Peripheral Component Interconnect

PEM

Privacy Enhanced Malil

PIN

Personal Identification Number

PKCS

Public Key Cryptographic Standard. A set of standards developed by RSA Laboratories for Public Key Cryp-
tographic processing

PKCS #11
Cryptographic Token Interface Standard developed by RSA Laboratories

PKI

Public Key Infrastructure

ProtectServer
SafeNet HSM

ProtectToolkit C

SafeNet's implementation of PKCS#11. Protecttoolkit C represents a suite of products including various PKCS#11
runtimes including software only, hardware adapter, and host security module based variants. A Remote client and
server are also available

ProtectToolkit J
SafeNet's implementation of JCE. Runs on top of ProtectToolkit C

R

RC2/RC4
Ciphers designed by RSA Data Security, Inc.
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RFC

Request for Comments, proposed specifications for various protocols and algorithms archived by the Internet Engin-
eering Task Force (IETF), see http://www.ietf.org

RNG

Random Number Generator

RSA
Cryptographic algorithm by Ron Rivest, Adi Shamir and Leonard Adelman

RTC
Real Time Clock

S

SDK

Software Development Kits Other documentation may refer to the SafeNet Cprov and Protect Toolkit J SDKs.
These SDKs have been renamed ProtectToolkit C and ProtectToolkit J respectively. & The names Cprov and Pro-
tectToolkit C refer to the same device in the context of this or previous manuals. @ The names Protect Toolkit J and
ProtectToolkit J refer to the same device in the context of this or previous manuals.

Slot
PKCS#11 slot which is capable of holding a token

SlotPKCS#11
Slot which is capable of holding a token

SO
Security Officer

Symmetric Cipher

An encryption algorithm that uses the same key for encryption and decryption. DES, RC4 and IDEA are all sym-
metric algorithms

T

TC

Trusted Channel

TCP/IP

Transmission Control Protocol / Internet Protocol
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Token
PKCS#11 token that provides cryptographic services and access controlled secure key storage

TokenPKCS#11
Token that provides cryptographic services and access controlled secure key storage

U

URI

Universal Resource ldentifier

V

VA
Validation Authority

X

X.509
Digital Certificate Standard

X.509 Certificate

Section 3.3.3 of X.509v3 defines a certificate as: "user certificate; public key certificate; certificate: The public keys
of a user, together with some other information, rendered unforgeable by encipherment with the private key of the
certification authority which issued it"
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